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Overview

The intent of the Detailed Modeling module is to move beyond template-based modeling and focus
on detail-oriented modeling. Because of the complexity of detail-oriented modeling, the module will
focus on a wide range of concepts. This includes traditional corridor modeling, complex plan
geometry, proposed terrain model development, and the introduction to a number of additional
tools/techniques that fall outside of the traditional template-based modeling scope. By leveraging
these tools and techniques, the user can take the traditional template-based corridor to a whole
new level of detail and complexity. In addition to the tools that were introduced in the previous
Corridor Modeling modules, the Terrain and Model Detailing ribbons will also play a major role
throughout the Detailed Modeling module.

Model Detailing Ribbon

T OpenRoadsModeling ~ [ S HE T « - » £ & = CANCDOT Training\Roadway\Module 11 - Detailed M|
“ Home Terrain Geometry Site Corridors Meodel Detailing Drawing Production Drawing Utilities iTwin
g, k . _H_L H Create Civil Cell —\ @ @ |‘:\ 7 Create Conic Slope
E v #- Process Civil Cell =* Create Transverse Align...
Element .. Place ., - Apply Surface Create e
L] Selection =+ Civil Cell 2k Drop Civil Cell Linearq'gmplate Templates *  Closed Mesh Elements~ = Create Transverse Tunnel
Primary Selection Civil Cells 3D Tools Technical Preview

Terrain Ribbon

[ . o L] _ ; .

d OpenRoads Medeling v Hl‘._:j ?::: - v f = = CANCDOT Training\Roadway\Module
m Home Terrain Geomnetry Site Corridors Model Detailing Drawing Production Drawing Utilitie

8, k @ T @ From File % @ % o 8By Edit Complex Model 1>
= o

E v 3| From Graphical Filter & Feature Management A5

Element .. Additional  Topo Active  Edit Transform
(=] Selection =/ Q From Elements Metheds »  Import ~ v Model -{:J‘ Boundary Options ~
Primary Selection Create Edit

Key Concepts, Tools and Terminology

Design Intent
Design Intent is the act of preserving rules and relationships established during the design process in
order to realize downstream benefits of automatic updates.

Linear Templates
Templates that can be applied quickly and easily to 3D linear elements but with less functionality
when compared to corridor templates.
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Surface Templates
A template made of components with an associated depth. These components are closed shapes such

as asphalt, concrete, aggregate, grass etc. Surface Templates are used to apply material thickness to
the surface of a terrain.

Terrain Modeling

A set of three-dimensional triangles mathematically computed from point data collected on the
surface being modeled. Models are used to define highly irregular surfaces, particularly the surface of
the earth, but can be generated for proposed surfaces, subsurface geotechnical layers, etc. Terrain
models are also referred to as digital terrain models (DTMs), triangulated irregular networks (TINs), or
triangulated surfaces.

Exercise 1 - Street Turnout Modeling

In this exercise, you will learn how to model a Side Street Turnout and Concrete Channelization
Island. This includes the mainline pavement shearing, horizontal/vertical layout, application of linear
templates, proposed terrain model development, surface template application, and various element
profiling techniques. Design Intent will continue to be a major focus.

Throughout this exercise you will be working with NCDOT 2D dgn files exclusively. All design and
corridor manipulation will be carried out within a 2-dimensional design plane.

1. Launch OpenRoads Designer CONNECT Edition
Double-click on the NCDOT Roadway OpenRoads icon on your desktop to launch \/
OpenRoads Designer into the NCDOT Roadway workspace. 2]

NCDOT
Roadway

2. Set the Workspace and Workset
Select DOT-US North Carolina from the Workspace menu.
Select NCDOT R-2635C (Training) from the Workset menu.

OpenRoads Designer CONNECT Edition

DOT-US North Carolina - R-2635C (Training) ~

3. Open the Exercise 1 Corridor (CMD) dgn file and zoom in closely to the Y8 Corridor
A. Click the browse button and path to the Module 11 (Detailed Modeling) folder and Browse

open the R-2635C-RDY_CMD_Exercisel.dgn file.
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B. Zoom in near the Y8 Corridor as shown below. Notice that the Y8 alignment already has a base
corridor. This base Y8 corridor will serve as a starting point for the Detailed Modeling exercise.
See the Initial Corridor Modeling Module for detailed instructions for initial corridor
development.

CORRIDOR

Note: All reference files that are required for the Detailed Modeling module have already been
attached to the R-2635C_RDY_CMD _Exercisel.dgn file.

4. Load Civil AccuDraw and the Feature Definition Toggle Bar > l o«
A. Click on the Civil AccuDraw button (Geometry > General Tools > Civil Toggles > Civil Mg,
AccuDraw) to load the Civil AccuDraw toolbar.
B. Click on the Feature Definition Toggle Bar button (Geometry > General Tools >
Standards > Feature Definition Toggle Bar) to load the Feature Definition Toggle ﬂ?
Bar.

Tip: Both of these toolbars will be used throughout the design/modeling process. Because of
this, it’'s recommended that both are docked for easy access.

5. Adjust the level and reference file display as needed to better facilitate design/modeling
A. With the View 1, Default view in focus, turn the display of the Default-3D view off as shown
below.

E| References (3 of 3 unique, 2 displayed) -

Tools  Properties

.E_IE - E T I :) (4 e } i :._‘ 7 ;{ = i }('j Hilite Mode: | None '

St P 4 FileName Model Description [l o-b? k ¥
1 SdlignmenttR-2633C_RDY_alg_exercisel.dgn Default Master Model ¥ oo¥
2 AuAFinal SurveyR-2633C-L5-ETM.dgn Default Master Model LA

[13 ./ R-2635C_RDY_cmd_exercisel.dgn Default-2D v W |
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B. Notice that the 3D model has been turned off, leaving just the linework. Depending on your
prefence, you may choose to turn off additional linear elements to avoid confusion.

fp—

6. Open an additional 3D view to better facilitate 3D modeling
A. Right-click within the View 1, Default view and hold to load the View Control
menu. From there, select the 2 Views Plan/3D option as shown below.

[ View Centrol P31 View y
7 Copy |5 2 Views Plan/3D 1
i::li:-fl Move (@ 2 Views Plan/X5

I:II Scale [@ 2 Views Plan/Profile

<k, Rotate (& 2 Views Plan/Superelevation
.'.?IL Mirror (@ 3 Views Plan/Superelevation/X5

O 3 Views Plan/Profile/30

% Select Links |3 3 Views Plan/Profile/xs

fas View Attributes (@ 3 Views Plan/X5/3D
Model Properties (@ 4 Views Plan/Profile/¥5/30

B. This will load the View 2, Default-3D view in addition to the standard View 1, Default view as
shown below. As you continue to develop your model you can now easily visualize it.

C. Then, click the Tile button (View > Window > Tile) as shown below to tile the two (2)
windows. This will make it easier to focus on both views at the same time.

View Help NCDOTRoad
s e =
| N O O O e
aved  Appl C C de Tile A Vi Prev  Mext
ety | e T T TR
we [ Window ;
— _—
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7. Layout the Horizontal Geometry for the Street Turnout
A. From the Feature Definition Toggle Bar, toggle on the Use Active Feature Definition
button and then select the Road_Edge of Travel feature from the (Linear > Roadway >
Pavement) folder as shown below. Keep this Feature active throughout all steps that follow.

Road_Edge of Travel /‘;\@? “ﬂ“rﬂ_\ﬁ; O.j

G-l Existing
USE ACTIVE -l Fence FEATURE
FEATURE - Guardrail and Barier DEFINITION
DEFINITION H- Interesection DROPDOWN
Miscellaneous |

-/ 1 Pavement

----- g |
----- @& Road_Fdge of Travel Dasﬁ
----- @& Road_Edge of Travel Shea
----- & FRoad_Lane Line A
i@ Road_Lane Line B

B o |l e B o

B. Next, select the Single Offset Entire Element tool (Geometry > Horizontal > Offsets and
Tapers > Single Offset Entire Element) and then select the street turnout centerline (Y8A)
when prompted to locate element.

Geometry Site Corridors Medel Detailing Drawing Preduction Drawing Utilities iTwvi
< Import/Export ~ whue P a ; TV Offsets and Tapers ™
l#% D : El i t Eend }é{ o O o — - 2

#3 Design Elements = . i : : :
N ¢ < Ciwil Reports Lines  Arcs F'c:intl e I _Complex
“¥ Standards ~ Toggles = v v v v Single Offset Partial secmetry "

General Tocls

Rl

Variable Offset Taper

e —

Y8
ALIGNMENT

ﬁ ,—_
\

R L

STREET TURNOUT
CENTERLINE (Y8A)
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C. Set the Offset parameter to 12.0000 and toggle on the Mirror option within the Single Offset
Entire Element dialog and click through the prompts to accept. This will draw the left and right
EOT lines for the Y8A street turnout. Y -

@ >ingle Offset E —

Parameters

—
—_
T —— e — s — — —_
—— —— s — s — — — — — —

""""""""""""""""""""""""""""""" Offset: 12.0000 § -

Use Spiral Transitions [_] =

Y8 s Mirror
e ALIGNMENT — Remove Offset Rule  [] . -
—~
STREET 5
TURNOUT
LEFT EOT
K STREET e —— e ————
______ TURNOUT
RIGHT EOT
D. Now, select the Simple Arc tool (Geometry > Horizontal > Arcs > Arc Between Elements >
Simple Arc). Set the Radius parameter to 35.0000” and the Trim/Extend parameter to Back
within the Simple Arc dialog as shown below.
Geometry Site Corridors Model Detailing Drawing Production Drawing Utilities i TwiF
— i - | - i ——— .
|1-6.._" :::ﬂp_ﬂméxpmt _:Ti_ ;;’:j\ FN CI ?_ :' ;]Ffsets a;d Tapers \er ff
“3 Design Hements Civil Reports | Lines  Arcs  Point _L:I_ EVErSE LHvEs Modify  Complex
Wh Standards * Toggles = - - - * = Spirals - - Geometry
—~ .
General Tools ~ il
fﬂ Arc Between Points >
Arc To Elerment
6%2 Simple - bt "™ Arc Between Arcs
Parameters . Arc From Element
Trim/Extend  Back » Arc Between Elements ] i’:l_
. F Spiral Arc Spiral
Radius 35.0000°
Yg Taperfrc Taper

Loop ]
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E. When prompted to Locate First Element, select the Left EOT line for the street turnout (Y8A)
and then select the Right EOT line for the Y8 Corridor as the Second Element. When selecting
the Y8 Corridor Right EOT line you may notice multiple linear elements sitting on top of one
another. To resolve this, Right-Click to cycle through them and choose the linear element on
level P_RDY_TL_Edge_of_Travel. It's very IMPORTANT to select the correct linear element.

F—-
—_——
el Bl S —
e TR S ——

i — ——— e m— — — — e — — — — —

Y8

s—msmscscscsceed Y8 CORRIDOR RIGHT EOT

P_RDY_TL_EDGE_OF TRAVEL |

______________ STREET

TURNOUT
LEFT EOT

e e —— T — —— i — — — — — — — — — ——

F. After selecting both elements, click through the additional prompts to place the 35’ radius as

shown below.

N

35’

RADIUS

e N
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G. Now, place a 35’ radius return on the other side of the street turnout following the previous
steps. This time select the Right EOT of the street turnout (Y8A) when prompted to Locate
First Element and then the Right EOT line for the Y8 Corridor as the second.

N .|
a— Y8 Y8 CORRIDOR
ALIGNMENT | RIGHT EOT

————— -
- — e — T — — —
P — — — — !

- — — —— ———

STREET
TURNOUT
RIGHT EOT

H. After selecting both elements, click through the additional prompts to place the 35’ radius as
shown below.

N
Y8 l
ALIGNMENT }

RADIUS
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I. Next, select the By Angle From Element tool (Geometry > Horizontal > Lines > Line From
Element > By Angle From Element). Set and lock the Skew parameter to 90° 00’ 00”, the Start
Distance parameter to 0.0000, End Distance parameter to -30.0000, and Name to Y8A TIE
within the By Angle From Element dialog as shown below.

Geometry Site Corridors Model Detailing Drawing Production Drawing Utilities i Twin

& Import/Export ~ _\'f_ AP 2 . 17 Offsets and Tapers =

|+ Design Elements = A" Rewverse Curves =

Civil Reports = Lines Arcs  Point Modify Complex
Y Standards * Taggles = r = i r = Snirals v ' Geometry =
- Line Between Points )
General Tools Jrizontal
; ; Line To Elermnent L
oy B :’-c Line Between frcs
@ By Ang — Y
F—— “.' Line From Element 4 Simple Line Frem Element
Shew |ED°DD'DD" I ; Spiral Line From Element
3 & .
Start Distance [0.0000 1 ¢+ Curve Line From Elernent
End Distance |-30.0000 | £2 | By Angle From Element
Feature L

Feature Definiion | Usze Active Feature

Name — |ysa TIE

J.  When prompted to Locate Element, select the centerline of the street turnout (Y8A). Drag
your mouse just beyond the radius returns and Left-Click the screen when prompted to Enter

Start Point. This will define the start point of a line from the Y8A alignment at a 90° skew as
shown below.

e
_ A
ALIGNMENT |
—5\
P ——— e —— 1__
Y8A
ALIGNMENT
Enter Skew
_/\A_ &b | Parameters:Skew 4p
Page | 11
START POINT
LOCATION
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K. Then, click through the additional prompts to finish placing the Y8A TIE line as shown below.

—/

Y8
ALIGNMENT

— i — i —— ——— =

Y8A
ALIGNMENT

Y8A TIE
N

L. Now, click on the line that was just placed and notice the Small Arrows that are displayed on
the outer end of each side. These Arrows can be used to manipulate the element they are

associated with.

Page | 12

LEFT
EOT

Y8A

ALIGNMENT f

MANIPULATOR
ARROW

_‘r’

D
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M. Left-Click and Drag the left side Manipulator Arrow just beyond the Left EOT of the Side

Street (Y8A) as shown below.

Y8A

ALIGNMENT f

LEFT
EOT

MANIPULATOR

!

| YSATIE

e - h

N. Next, modify the Y8A TIE line widths on both sides of the Y8A alignment to -12” as shown
below. The Y8A TIE line represents the location where the Side Street (Y8A) ties to existing.

\

Y8A
ALIGNMENT

f

-12.00001

i
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0. Next, select the Trim To Intersection tool (Drawing > Modify > Trim To Intersection) aN
and trim the Street Turnout (Y8A) EOT and TIE lines and as shown below. [

------------------------------------------------------------------------------- Y8
ALIGNMENT

Y8A
--------- =+ ALIGNMENT F{—

TRIM i

TRIM

8. Demonstrate the Horizontal Design Intent associated with the Street Turnout
A. When the EOT lines were Trimmed in the previous step, a Rule was created. Click the EOT
line that was drawn at a 90° degree angle from the Y8A alignment as shown below. Notice the
Manipulator Handle that is displayed in the center.

Y8A
ALIGNMENT

'y
'}
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B. Next, click, hold, and drag the Manipulator Handle at the intersection up and down along the
Y8A alighment and notice that the line moves as well.

ALIGNMENT

—

MANIPULATOR
HANDLE

——

C. Now, Toggle Civil AccuDraw on and select the Station-Offset icon as show below.

Civil AccuDraw

[=]

STATION-OFFSET

TOGGLE CIVIL
ACCUDRAW ON

D. After activating Civil AccuDraw, click, hold, and drag the Manipulator Handle at the
intersection again. Notice that the Civil AccuDraw dialog now loads as well, and is tracking
your movement along the Y8A alignment as show below.

AN
______________________________________________________ Y8
ALIGNMENT
Y8A
ALIGNMENT [T 7 —

Station
MANIPULATOR Offset |-40.0760°
HANDLE
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E. Key-in 10+75.00 and then left click the screen to place the line as shown below. Notice
that the left and right EOT lines move as well because of the rule that was created previously
when using the Trim To Intersection command.

Y8 -
ALIGNMENT

Y8A
ALIGNMENT

KEY-IN
10+75.00

Offset |6.3683

F. Toggle Civil AccuDraw off as shown below but keep the Civil AccuDraw toolbar loaded.

L o A A
A':rT @c} Cﬁz} J —n-T ,ff/—!{

TOGGLE CIVIL
ACCUDRAW OFF
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9. Shear the Y8 pavement through the Y8A Side Street intersection
A. From the Feature Definition Toggle Bar, toggle On the Use Active Feature Definition
button and then select the CCE_Target_EOT_Shear_Out_RT feature from the (Linear >
Roadway > Construction Class Element) folder as shown below.

|| cCE_Target_Shear_out_RT v| g% M A S
----- & CCE_Target_EOT Out_RT A
USEACTIVE | = - @ CCE Target GS - TOGGLE OFF
FEATURE | | & & CCE_Target_P5 PEESNIETRSUNL?PS
----- @& CCE_Target_Shear_In |
DEFINITION ¢+ ©. @& CCE_Target_Shear Ouwt_LT ;

----- "M CCE_Target_Shear_Out_R
----- @& CCE_Target_SW_LT

----- @ CCE Target SW_RT
[ AT

B. Select the Single Offset Partial option (Geometry > Horizontal > Offsets and Tapers > Single
Offset Partial) as shown below and select the Y8 Alignment when prompted to Locate
Element.

Geometry Site Corridors Maodel Detailing Drawing Production Drawing L

1 Import/Export = o Y L, CF Offsets and Tapers = ;
4% D F El F' e K ¥ " O A d ’ -7
@3 Design Elements = - i

. Civil Reports LIHES Arcs Point | — fng z iz dr=Ran

“ Standards ~ Toggles~ - v v T O Single Offset Partial |,

VA N
___________________ v8 |
ALIGNMENT
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C. When prompted for a Start Station, snap to the end of the left-side radius as shown below.

-1 - -

SNAPTOEND |
OF RADIUS P

-

D. Next, snap to the end of the right-side radius as shown below to place the shear line as shown
below.

SHEAR LINE

| SNAP TO END
OF RADIUS
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E. Click the Y8 Corridor Object Handle, hover for a moment to display the menu, and then select
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the Add Corridor Reference option as shown below.

— e — — — — — — — — —

{[ {/ Y8 CORRIDOR
' OBJECT HANDLE

O -7 R X

3 P

ADD CORRIDOR
REFERENCE

g2

&%

F. After adding the Shear line as a Corridor Reference, the EOT is sheared as shown below.

N

""""""""""" Y8 E -

Y8A

] ALIGNMENT
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G. Notice that the pavement has also been sheared within the View 2, Default-3D view as well.

SHEARED Y8
PAVEMENT

10. Profile the Side Street (Y8A) EOT lines
A. Click the Y8A TIE line shown below, hover for a moment to display the menu, and then
select the Open Profile Model option.

- — =

YSATIE
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B. When prompted to Select or Open View, click the View 5 option, within the View Groups

group (View > View Groups) and then, left click within the view to open the Y8A TIE line
profile view as shown below.

View Help NCDOT Roadway

O TR OO &®m234567 4

ved Ap Cu:up}r Cascade Tile Arrange Yiew Prev DNext All = - .
1gs Save clp‘uyam Size E - (5 Multi-Maq \/JEW 5
s Fl Window View Groups K
B View 5, Profile - V84_TIE [ro| -2 3]
344,24
s
344. 1 __.....--"'"""
-
-
3440 —
’F"
-
343,94 __.--'“
-
-
343.81 -
-
343.71 -
-
-
343 G ———— ——
QP ég,l ol Q,I 0Q,I QQ,I ';:P'I Q| Q,gl 'CPI QI QQJ QPI ég,l Q,I Q('_n,l Q,I ';:P'I o
'::,“\'Q"’Q Qﬁqpq’a R N o ,:'I»Q"'L"L-,"l«ﬁ
VA S o S S S Rl Q‘J Qh ‘b % Q: Q! Ny (b Q Qn SN o o ol

C. Now, Click the existing Y8A TIE line shown below, hover for a moment to display the Profile

Menu as shown below, then select the Set as Active Profile option.

EXISTING Y8A
TIE

SET AS ACTIVE
PROFILE
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=

D. Notice in the View 2, Default 3D window that the Y8A TIE line is now displayed in the 3D
model. This is because it now has a vertical attribute associated with it.

l YSATIE

E. Move your mouse 12’ to the left of the Y8A alignment and notice the pink line as displayed
below. This line represents the Y8A left EOT line in its original state before it was trimmed. This
line acts as a parent to the small, trimmed EOT section that is still visible.

< Y8A L
W ALIGNMENT

TRIMMED
LEFT EOT
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F. Click the Left EOT line shown below, hover for a moment to display the menu, and then
select the Open Profile Model option.

i ---{ LEFTEOT If - - R LT TR R
a2 7 %! X

OPEN PROFILE
MODEL

Y8A o
ALIGNMENT

G. When prompted to Select or Open View, click the View 5 option, within the View Groups

group (View > View Groups) and then, left click within the view to open the LEFT EOT profile.

View Help NCDOT Roadway

[

E = e =N @123456?3

ved  Ap Copy Cascade Tile Arrange ‘u‘lew Prev  Mext A”
1gs Save \:Ip‘uyew View Size - 01 Multi-Mog v jEw 5
s ] Window View Groups
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H. Now, click the existing Y8A LEFT EOT line shown below, hover for a moment to display the
Profile Menu as shown below, then select the Set as Active Profile option.

EXISTING Y8A
LEFT EOT
(B |$§ ))v eV 4
| N —
SET AS ACTIVE
PROFILE

I. Notice in the View 2, Default 3D window that the TRIMMED LEFT EOT line is now displayed in
the 3D model. This is because the LEFT EOT now has a vertical attribute associated with it and
there is a Parent/Child relationship between the LEFT EOT line and the TRIMMED LEFT EOT

line.

e —

TRIMMED 2 ———
LEFT EOT
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J.  From the Feature Definition Toggle Bar, toggle on the Use Active Feature Definition
button and then select the Road_Edge of Travel feature from the (Linear > Roadway >
Pavement) folder as shown below. Keep this Feature active throughout all steps that follow.

Road_Edge of Travel | ~ QEE ‘ l"I"' r&.\ éa’; o—ﬂ?

- Existin
USE ACTIVE :: - FEATURE
FEATURE ﬂ Guardrail and Bamier DEFINITION
DEFINITION | [ Interesection DROPDOWN
- Miscellaneous !
EI Pawvement

B Road Fdge of Travel

- @& Road_Edge of Travel Dash
- @& Road_Edge of Travel Shea
- @ Road_Lane Line A
----- # PRoad_Lane Line B

- - WP — N ) 1 =

K. Next, select the Quick Profile Transition tool (Geometry > Vertical > Element Profiles > Quick
Profile Transition) as shown below.

Geometry Site Corridors Model Detailing Drawing Production Drawing Utilities iTwin View Help NCDOT Roadway

vl / - ! %) I -3 = - ——
1< Import/Export _,\-T:_ ;Q; A O ﬂ_ ¥ Offsets and Tapers \fﬂ f; EE Open Profile Model |\\ E |_J:L 1 &

%5 Design El ts ~ : = R C o % Set Active Profile
%4 Design Elements Civil Reports | Lines Arcs  Point ‘_3_ FVEIE Lunves Modify  Complex % Lines Curves Element Modify Complex
i Standards ~ Toggles = v - v v ZL Spirals ~ - Geometry * | | Profile Creation ~ v v Profiles = v Geometry ~
General Tools Horizontal Vertical L IQuick Profile Transition I
m o » E

L. Then, set the Quick Transition Method to Parabolic, left click to accept, and then select the
Y8A Left Side Radius on the left side of the Y8A alignment as shown below.

""" Y8A LEFT SIDE
RADIUS

Y8A
ALIGNMENT

— — i —— — — T — —— —— —

— e — e —

Quick Transition Method
Parameters:GQuick Transition Method s
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M. Click the Y8A Left Side Radius shown below, hover for a moment to display the menu, and
then select the Open Profile Model option to open the Proposed Y8A Radius profile.

Y8A LEFT SIDE
""" RADIUS

OPEN PROFILE
MODEL

N. Notice the Proposed Y8A Radius profile that was created using the Quick Profile Transition
tool. The Quick Profile Transition tool created a best-fit profile for the Y8A Left Side Radius.

A T MATCHES SLOPE
PROPOSED Y8A ™!  OF Y8RIGHT EOT
LEFT SIDE RADIUS iy EXISTING Y8A
PROFILE LEFT SIDE RADIUS
7 PROFILE

MATCHES SLOPE OF
EXISTING

Note: This profile is dynamic. If the Y8 profile is changed, the Proposed Y8A Left Side Radius will
reflect this change.
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O. Notice in the View 2, Default 3D window that the Proposed Y8A Left Side Radius is now
displayed in the 3D model.

N PROPOSED Y8A
@ LEFT SIDE RADIUS
PROFILE

P. After profiling the Y8A Left EOT lines, follow these same steps and profile the Y8A Right EOT
lines to finalize the Side Street (Y8A) vertical as shown below.

FINALIZED Y8A
EOT LINES

Note: The methodology used to profile the Y8A EOT lines is just one of several ways using
OpenRoads Designer. See the Vertical Alignment module for more detailed information on
OpenRoads Designer Vertical Geometry tools and methodology.
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11. Complex the Side Street (Y8A) EOT lines
A. Select the Complex By Element tool (Geometry > Horizontal > Complex Geometry > Complex
By Element) as shown below.

Geometry

1 Import/Export = by A g L
A ot }ﬁﬁ /S O ¢

|73 Design Elements ~

W Standards *

General Tools

Civil Reports  Lines  Arcs  Point

Toggles - v

Site Corriders Model Detailing Drawing Production Drawing Utilities i Twin View

T Offsets and Tapers * \J,J ;’f BB Open Prt

A Reverse Curves =

] |45 Set Activi
Modify  Complex

2. Spirals + *  Geometry* | Profile

- e

Horizontal ey

Complex By Element

B. Then, Key the following parameters into the Create Complex Element dialog and select the
small tangent EOT as shown below. When selecting the EOT line, make sure the Directional
Arrow is pointing in the correct direction before accepting.

Page | 28

Method = Automatic
Name = Y8A RIGHT EOT

4'?5.7 eate C —

Parameters

Method |;1'-.|_rtu:umatic

Maximum Gap |I}_D328

\

DIRECTIONAL
ARROW

EOT

Feature

Feature Definition |Lse Active Feature

Name Y8A RIGHT EOT

i Y8A
’ | ALIGNMENT | =~ S

e ——— ————
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YSARIGHT | _—_.
EOT

D. Click the Y8A Right EOT shown below, hover for a moment to display the menu, and then
select the Open Profile Model option to open the Y8A Right EOT profile.

Y8A RIGHT
EOT
/!

HEX %5 s K X

OPEN PROFILE
MODEL
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Select the Profile Complex By Element tool (Geometry > Vertical > Complex Geometry >
Profile Complex By Element) as shown below.

ion Drawing Utilities 1Twin View Help MCDOT Roadway

s and Tapers © \J,..J ,7""{ EB Open Profile Model b ‘: Ii I & E&—.}} /'/

=rse Curves ~ [#5 Set Active Profile

Modify  Complex Lines Curves Element Modify Complex Transform  Simplify
als v - Geometry > | /¢ Profile Creation ~ v = Profiles ~ v Geometry * Geometi]
‘orizontal - Vertical Io= | Profile Complex By Elements

Then, similar to how the horizontal Y8A Right EOT was complexed, Key the following
parameters into the Create Complex Profile Element dialog and select the small tangent EOT
as shown below. When selecting the EOT line, make sure the Directional Arrow is pointing in
the correct direction before accepting. It may be helpful to turn the existing ground line off if
you have trouble selecting the tangent EOT.

e Method = Automatic
¢ Name = Y8A RIGHT EOT

Parameters

Method |;1'-.|_rt|:umatic
Maximum Gap |I}_D328

Feature

DIRECTIONAL
ARROW

Feature Defimtion |Usze Active Feature

Mame 3A RIGHT EQT

EOT
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G. This creates a new complex vertical element called Y8A RIGHT EOT as shown below. Set Y8A

Right EOT as the Active Profile.

Y8A RIGHT
EOT

SET AS ACTIVE
PROFILE

H. After complexing the Y8A Right EOT lines, follow these same steps and complex the Y8A Left

EOT lines.

12. Apply Linear Templates to the Left and Right Y8A EOT lines

0\

A. Select the Apply Linear Template tool (Model Detailing > Apply Linear Template).

B. Key the following parameters into the Apply Linear Template dialog.

e Start = Lock To Start
e End=Lock To End

e Exterior Corner Sweep Angle = 05° 00’ 00”
e Template = LNT - C&G Berm Catch Slopes

e Feature Definition = Design
e Name =YS8A LEFT EOT

Parameters

Lock To Start
Start Station 0.0000
Lock To End
End Station 0.0000

Apply
Linearﬁl'gmplate

Pick Template

= CANCDOT TrainingRoadway \Module 11 - Detailed M
& Project Templates
- Linear
i i-Concrete lsland Template
-Concrete lsland Template Linear
2 LMT- C&G Berm Catch Slopes
i -LNT-C&G Berm Catch Slopes with SW
-- Roadway Templates
[ Surface Templates

Exterior Corner Sweep Angle |D5’DD'DD"
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=

C. When prompted to Locate Element To Apply Template, select the Y8A LEFT EOT and begin
clicking through the prompts. When prompted to Select Side, move your cursor as shown
below and then continue clicking through the prompts to place the Linear Template.

Select Side - Reflect Option
Mirror - <Alt> Down To Select

D. Notice in the View 2, Default 3D window that the Y8A Left EOT Linear Template is now
displayed in the 3D model as shown below.

e e e e o e e e i e e P e P s S S e )

Y8A LEFT EOT
LINEAR TEMPLATE

E. After applying the Linear Template to Y8A Left EOT, follow these same steps and apply the to
the same Linear Template to Y8A Right EOT as shown below.

Y8A RIGHT EOT

LINEAR TEMPLATE
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13. Create a Proposed Terrain for the Side Street (Y8A)
A. First, select the Project Profile To Element tool (Geometry > Vertical > Profile Creation >

Project Profile to Element) as shown below.

Geometry Site Corridors Model Detailing Drawing Preduction Drawing LUtilities iTwin View Help NCDOT Roadway

\ Import/Export ¥ e > ” y “V Offsets and Tapers ~ HBH Open Profile Model
|‘6' D p' fEI : t: _’T: ;?{; Cr O A R C : J‘J |55 S:‘.Active Profile |l E
e esign Elements ™ - A heverse Curves ™ 2 b
‘ g Civil Reports Lines  Arcs  Point Modify  Complex ‘ Lines Curves E
%n Standards ~ Toggles = - - - ~ =L Spirals ~ - Geometry = [¥ Profile Creation ~ - = P
General Tools Horizontal l,.z_'—\ Profile From Surface
. = 0p rsel - ’

# Cuick Profile Frem Surface

[*2 | Project Profile To Element

B. When prompted to Select Element To Project, select the Right EOT line for the Y8 Corridor.
When selecting the Y8 Corridor Reft EOT line you may notice multiple linear elements sitting
on top of one another. To resolve this, Right-Click to cycle through them and choose the linear
element on level P_RDY_TL_Edge_of Travel. It's very IMPORTANT to select the correct linear

element.

Y8 CORRIDOR RIGHT EOT
""""""""" P_RDY_TL_EDGE_OF_TRAVEL |

L o N IIMIIII
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C. Then select the Shear Line on level Draft_RDY_Construction_Element when prompted to
Select Plan Element To Project Onto.

D. Notice in the View 2, Default 3D window that the Shear Line is now displayed in the 3D model
matching the Y8 EOT as shown below.

SHEAR LINE
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E. Now, select the Element Selection tool (Terrain > Selection > Element Selection) and *
Toggle ON the Add option as shown below. Element
Selection

i Elerment Selection - ot

F. Then, select he four (4) elements Highlighted in Blue below. Because there are multiple
elements sitting on top of one another, you may need to Right-Click through the elements to

select the ones you need. If your still having trouble, try turning off some of the additional
levels.

SHEAR LINE

Y8ALEFT b Y8A RIGHT

— e —— i ——

—— — i — — ———

YSA_TIE
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G. Now, select the Create Terrain From Elements tool (Terrain > Create > From Elements) as
shown below.

Terrain Gecmetry Site Corridors Jr

1;‘;: i1~ ¢ FromFile g‘”‘ ,
=8| From Graphical Filter ]

o dditional
=i An From Elements Methods »

’
ttion o Create o

— 4 o = -

H. Still keeping those four (4) elements selected, key the following parameters into the Create
Terrain From Elements dialog.

- @ Mo heature Detinition

e Feature Type = Boundary i _ 4
2= Termain y
e Edge Method = None -1 NCDOT ]
e Feature Definition = PT_Triangles it §
Q PT_ Boundary j
JF;; Create Terr — Y i@ PT_Cortours y
) 1 ~@ PT_Contours and Triangles
Parameters 2 - @ PT_ Drainage Contours 1
7 - @ PT_ Thematic Height 1
Feature T‘-,rpe |BDIJI'IdEIﬁ' -} & PT Thematic Slope 1“
Edge Method None F s ] .
4
Feature é
4
Feature Definition |F‘T_ Triangles 1
g a—_———1 . —

I.  Finally, Left-Click through the prompts to create the Side Street (Y8A) Terrain Model as shown
below.
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14. Apply Pavement Surface Template to the Side Street (Y8A) Terrain Model
A. Select the Apply Surface Template tool (Model Detailing > Surface Templates > Apply Surface
Template) as shown below.

Medel Detailing Drawing Productios
4

DA @B
Apply surface Create j
arq'gmplate Templates > C|osed Mesh Elj

& Apply Surface Templatej

e

B. Then, key the following parameters into the Apply Surface Template dialog as shown below
and select the Y8A Terrain Model from within the View 2, Default 3D window when prompted
to Locate Terrain Model.

e Template = SFT-Pavement
e Feature Definition = Disable Linear Features

Pick Ternplate

o

: Apply Surface Template — } 1
ﬁ ' 3 = CANCDOT Training ' Roadway Module F
General 4 =) Project Templates i

. -- Linear 1

Template |F'roject Templates'\Surface Templates\SFT-Pavement [+ Roadway Templates 1
Lpply External Clip Boundary [ I =B Syl'fﬂﬂe Templates ¥
" ) SFT-Concrete }

Feature i SFT-Concrete Island ]
Feature Definition |D1'sable Linear Features \
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-

C. Continue left clicking through the prompts to apply the SFT-Pavement Surface Template to
the Y8A Terrain as shown below.

s i RS
e ——————

r—— e S ————. =
— e

SFT-PAVEMENT
SURFACT
TEMPLATE

D. Turn off the Terrain Levels to better see the SFT-Pavement Surface Template as shown below.

SFT-PAVEMENT
SURFACT
TEMPLATE
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15. Add a Concrete Channelization Island to the Side Street (Y8A)
A. From the Feature Definition Toggle Bar, toggle on the Use Active Feature Definition
button and then select the Monolithic Island feature from the (Linear > Roadway >
Intersection) folder as shown below. Keep this Feature active throughout all steps that follow.

eQIIMonoI'rthic Island I ~ |e!;? 4 "’I" r&‘\ é}? e

= Roadway
- Bridge

USE ACTIVE FEATURE

FEATURE G- Civil Cell DEFINITION
DEFINITION Construction Class Element DROPDOWN
(- Culvert >
G- Curb and Gutter
G- Ditch
G- Existing
---ﬂ Fence
---ﬂ (Guardrail and Barrier
EI Interesection
e
X Miqru-\."- sanL |

B. Next, select the Single Offset Entire Element tool (Geometry > Horizontal > Offsets and
Tapers > Single Offset Entire Element) and key the following parameters into the as shown

below.
Geometry Site Corridors Maodel Detailing Drawing Production Drawing Litilities i Twi
rd / - | o L eer .
|_'d.: ::rl-np-ort.-;xport _:T:_ ;§~ ) . O yo — Offsets and Tapers o
o tz Ly —— g 3 .
. L Civil Reports Lines Arcs Point I —0 Sl i A I _Complex
“# Standards ~ Toggles = v = b b 7 Single Offset Partial seocmetry ',
General Tools ~I  Variable Offset Taper
e Offset =12.0000 d@ Single Offset E..  —
e Use Spiral Transitions = Unchecked Parameters ~
e Mirror = Unchecked Offset 12,0000 :
e Remove Offset Rule = Unchecked Use Spiral Transitions [ ]
Mirrar O

Remove Offset Rule [
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C. Then, select the two (2) Y8A EOT radius returns and follow the prompts to place the two (2)
Island Edges as shown below.

________________________ T
ALIGNMENT [ SLAND
ISLAND
FrrRRFRRRERREER EDGEl FFEEFEFEFFFEFEREFEFE

RADIUS
RETURN 2

RADIUS
RETURN 1

D. Change the Offset value to 4’ within the Single Offset Entire Element dialog, this time
selecting the Y8 Right Shear Line as shown below to place the 3™ and final Island Edge line.

Y8RIGHT |------------
SHEAR LINE

ISLAND
EDGE

1 Fd
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E. Next, select the Simple Arc tool (Geometry > Horizontal > Arcs > Arc Between Elements >
Simple Arc). Set the Radius parameter to 2’ and the Trim/Extend parameter to Both within
the dialog as shown below.

Geometry Site Corridors Model Detailing Drawing Production Drawing Utilities i Twir

1< Import/Export ~ e &P A 3 Offsets and Tapers = E
o Z 22 e N ,-

i Design El ts ~ “aAR C E
| Design Elements Ciwil Reports Lines Arcs Point — oo Ve Modify  Complex |

“h Standards * Toggles = - - =L Spirals ~ Geometry =
General Tools - drdz ]

r - - ;"ﬂ Arc Between Points ;, - R
Arc To Element i
@ simple o } ™ Arc Between Arcs 4
Parameters *' Arc From Element ;

Trim/Extend  Bath * B Arc Between Elemer_1ts : i’:l
Radius 5 0000 E :ﬂ_ Spiral &rc Spiral
y— |:| J rg  Taperdfrc Ta;_:ler_ ~

F. Now, use the Simple Arc tool to fillet the three (3) corners of the concrete island as shown
below.

’
4444444444444 4441 EEEE EEEE]

A4 T3 A 444444414444

P—
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G. Select the Complex By Element tool (Geometry > Horizontal > Complex Geometry > Complex
By Element). Set the Method to Automatic and click on the Concrete Island when prompted.

Geometry Site Corridors Model Detailing Drawing Production Drawing Utilities i Twin View

s
£ Import/Export ~ e ) - L % Offsets and Tapers = EH Open F'rE
w2/ 0 < N

|45 Design Elements = A Reverse Curves = |5 Set Activ;

i Civil Reports | Lines  Arcs  Point Modify = Complex
Wy Standards ~ Toggles - u v u * =L Spirals ~ o Geometry * | Profile @
|
General Tools Horizontal Comoplex By Elemen '
J— . ~ —— e N e Fy e ” = . P > fj,l "FI }r tjl

H. Click through the additonal prompts to complex the Concrete Island, making it a single
complex element.

JF;'; Create — 3

Parameters f

Method |A|_rt|::matic ’

""""""""""""""""""""""""""""""" "~ Maximum Gap |ﬂ_1}328 ;"

—— i — — —

L
CONCRETE
ISLAND

Locate First Element |,
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I. Next, select the Quick Profile From Surface tool (Geometry > Vertical > Profile Creation >
Quick Profile From Surface) and select the Concrete Island when prompted to Locate
Reference Element.

Geometry Site Corndors Model Detailing Drawing Production Drawing Utilities iTwin View Help NCDE

- : copo ; E
1< Import/Export ~ o %ﬁ - 3 Offsets and Tapers ~ EH Open Profile Model \
0 / < v ™

|44 Design Elements ¢ % Reverse Curves |45 Set Active Profile

. Civil Reports | Lines Arcs  Point Modify  Complex Lir:-;
Wn Standards T Toggles - v v v - A Spirals ~ v Geometry * | | Profile Creation = :
General Tools Horizontal . b~ Profile From Surface 1
— — — == R =

- I Cuick Profile From Surface l

= T

CONCRETE
ISLAND

FEEFEEFEEEEERERFRERREREE FEFEFEEEEREREREEEEREREEEEEL

- - —————— —

J. Then, select the Side Street (Y8A) Terrain Model when prompted to Locate Reference
Surface. Right click to reset and finalize the command.

Y8A TERRAIN

e 8
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K. Click the Concrete Island shown below, hover for a moment to display the menu, and then
select the Open Profile Model option to open the Proposed Concrete Island profile.

FEFFEEFEEFEEFRE R R FEFFREFEFFEEFEFFEFEFFE A B bR EEE R FEEFRE R FEEEEE

—_——— e ————

- ——— o ———

| CONCRETE [/
ISLAND

gf‘ﬂ HEAR e R

OPEN PROFILE
MODEL

M. Notice the proposed Concrete Island profile that was created using the Side Street (Y8A)
Terrain Model as shown below. Set this as the Active Profile and then close out of the profile
window.

PROPOSED
CONCRETE
ISLAND PROFILE

SET AS ACTIVE
PROFILE
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N. Notice in the View 2, Default 3D window that the Proposed Concrete Island is now displayed
in the 3D model matching the surface of the Side Street (Y8A) Terrain Model as shown below.

Y8A TERRAIN
MODEL

CONCRETE
ISLAND

O. Select the Apply Linear Template tool (Model Detailing > Apply Linear Template)
. . . . A |
and key the following parameters into the Apply Linear Template dialog. Linearﬁl'grzplate

e Start = Lock To Start
e End=LockTo End

e Exterior Corner Sweep Angle = 05° 00’ 00” 48 Apply Liner Templte - -
. Parameters -~
e Template = Concrete Island Template Linear
Lock To Start
e Feature Definition = Design Start Staton 0.0000
e Name = Y8A ISLAND Lock To End
End Station 0.0000"
) Exterior Corner Sweep Angle |D5'DD‘DD" |
Pick Template b Mirror 0
== C_:‘\NCDOT Training“Roadway Module 11 - Detailedi\ Reflect O
=- Z@JTJC: TEFHD|E'EES r Template |Pr0jed Templ, Linear'Concrete lsland Template Linear |
- Linear Descript
i i~ Concrete lsland Template 1 — | |
| Concrete Island Template Linear ? IS =
-LMNT- C&G Berm Catch S|0DE-'5 } Feature Definition |De5ign ~ |
- LMT- C&G Berm Catch Slopes with SW Name [r8IsLAND |

-- Roadway Templates 3
- Surface Templates VJ

el bt it -L¢___.-k_.——.____._'~&f r—
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P. When prompted to Locate Element To Apply Template, select the Concrete Island and begin
clicking through the prompts. When prompted to Select Side, move your Cursor to the inside
of the Concrete Island as shown below and then continue clicking through the prompts to
place the Linear Template.

LINEAR TEMPLATE ON
THE INSIDE OF THE
CONCRETE ISLAND

EEEEFEEEEFRFEFEFFEFFEEFFFRERREEY T Ry}

Select Side - Reflect Option
Mirror - <Alt> Down To Select

Q. Notice in the View 2, Default 3D window that the Y8A Concrete Island Linear Template is
now displayed in the 3D Model as shown below.

Y8A CONCRETE
ISLAND LINEAR
TEMPLATE
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R. Next, select the Element Selection tool (Terrain > Selection > Element Selection) and

select the top of the Y8A Concrete Island Linear Template. See the element highlighted

Element
in blue below. Selection

TOP OF Y8A
CONCRETE ISLAND
TEMPLATE

Tip: Zoom in closely and right click to tab through until you get the correct line.

Now, select the Create Terrain From Elements tool (Terrain > Create > From Elements) as
shown below.

Terrain Geometry Site Corndors f

w7 1+ From File %‘“ )
o =2 Fromn Graphical Filter 1
- L E Additinna;
=1 Ay From Elements Methods ¥
¥
-ti Creat
RS R )
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T. Still keeping the Concrete Island Linear Template selected, key the following parameters into
the Create Terrain From Elements dialog.

e Feature Type = Boundary
e Edge Method = None
e Feature Definition = PT_Triangles

48 Create Terr..  — }EJ

X -~ & No Featurs Uetinttion F
=~ Temain
Parameters f 20 NCDOT {
= - Exist }
Feature Type | Boundary ; =4 Prop )
: @ PT_Boundary 4
Edge Method |NDF‘IE! 4 i@ PT_Contours ¥
4 “-@ PT_Contours and Triangles 1
1 i@ PT_Drainage Cortours 1
Feature ! @ PT_Thematic Height 1
. : 3 & PT_Thematic Slope i
Feature Definition |F‘T_ Triangles E @ PT_Trangles :
—t = = E

> L e — — — T -

U. Left click through the prompts to create the Y8A Concrete Island Terrain Model as shown
below.

Y8A CONCRETE
ISLAND TERRAIN
MODEL
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V. Select the Apply Surface Template tool (Model Detailing > Surface Templates > Apply Surface
Template).

W. Then, key the following parameters into the Apply Surface Template dialog as shown below
and select the Y8A Concrete Island Terrain Model from within the View 2, Default 3D window
when prompted to Locate Terrain Model.

e Template = SFT-Concrete Monolithic Island-Simple

e Feature Definition = Disable Linear Features Pick Template

I
=~ CANCDOT Training*Roadway'Module 11 - Detailed M
=N Project Templates

-- Linear

-- Roadway Templates

- Surface Templates
SFT-Concrete Manalithic Island-Simple
. 5FT-Pavement

ﬁ Apply Surface Template — *

General

Template |F‘mject Templates'.Suface Templates'\SFT-Concrete Monolithic Island-Simple
Lpply External Clip Boundary []

Feature

Feature Definition |D1'sab|e Linear Features

Y8A CONCRETE
ISLAND TERRAIN
MODEL

X. Continue left clicking through the prompts to apply the SFT_Concrete Monaolithic Island-
Simple Surface Template to the Y8A Concrete Island Terrain as shown below.

SFT-CONCRETE
MONOLITHIC
ISLAND SURFACE
TEMPLATE
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Y. Turn off the Terrain Levels to better see the applied SFT_Concrete Monolithic Island-Simple
Surface Template.

Sl
SFT-CONCRETE
MONOLITHIC
ISLAND SURFACE
TEMPLATE

16. Adjust the berms and slopes of the Side Street (Y8A) Radius Returns to match Y8
A. Notice that the berm and slopes of the Side Street (Y8A) do not match the Y8 as shown below.
This can easily be resolved by using Parametric Constraints.

10’ BERM

10’ BERM |8
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B. Select the Create Parametric Constraint option (Corridors > Edit > Edits > Create Parametric
Constraint) and then select the Side Street (Y8A) radius return Corridor Object when
prompted to Locate Corridor.

Corridors Medel Detailing Drawing Production Drawid

1 Copy Template Drop ; hl £|| zg ¥

Yg Import IRD — T &
Template Edit Bdits

.,”,I Transitions = Template Drop ]

Create End Condition Exception
Create Edit ~ Create Key Station

|-'|-|- Create Secondary Alignment

I |:{.| Create Pararmnetric Constraint
W Create Curve Widening
H Create Point Control

B CORRIDOR
—_— OBJECT

o ol o o R R L o o o o o o o o o

SIDE STREET
(Y8A)

— —— —

ocate Corridor

C. Key the following Parameters into the Create Parametric Constraint dialog and click through
the prompts to set the BM_Width Parametric Constraint and transition the Berm Width from
8’ to 10’ over the length of the Radius Return to match the Y8 Berm.

e Start = Lock to Start d&

e Stop = Lock to End Parameters

e Constraint Label = BM_Width Lock To Start

e Start Value = 8.0000 Start 0+00.00

e Stop Value = 10.000 Lock To End
Stop (+559.48

Constraint Label |[BM_Width
Page I 51 Start Value 8.0000
Stop Walue 10.0000
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D. Next, use the SS_Slope Fill Parametric Constraint to transition the Y8A Fill Slope from 2:1 to
4:1 over the length of the Radius Return to match the Y8 Fill Slope.

Parameters

e Start = Lock to Start

e Stop = Lock to End

e Constraint Label = SS_Slope Fill
e Start Value = -50.00%

e Stop Value =-25.00%

Lock To Start
Start 0:+00.00
Lock To End

Stop 0455 48

1t b ]

Constraint Label |55 Slope Fil
Start Value -50.00%
Stop Walue -25.00%

E. Now, follow these same steps and do the same for the other Y8A Radius Return as shown
below.

Y8A RADIUS

KRR R R NP P] 1114411 RETURN 111441 - -
SIDE STREET

(Y8A)

\

Locate Corridor

?(
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17. Clean up the breaks in the intersection using Key-Stations
A. Notice the breaks in the intersection model as shown below. This can be resolved by adding

Key Stations.

BREAKIN
BREAKIN INTERSECTION
INTERSECTION MODEL
MODEL

B. Select the Create Key Station tool (Corridors > Edit > Edits > Create Key Station) and add the

following two (2) Key Stations.
Corridors Meodel Detailing Drawing Production Drawi{

o KeyStation1=12+12.99 5 CopyTempiateDrop X, Sy 2
. g

e Key Station 2 = 13+07.01 fg Import IRD Template cait | Edits O | f

Wl Transitions - ) lemplate Dmp i C‘r“eate End Condition Exception
L=k - L !;;' Create Key Station I

TR, H“ Create Secondary Alignment

|._P,| Create Parametric Constraint

--------------------------------------------------------- "% Create Curve Widening
KEY |[#+  Create Paint Contral
STATION 1 FFFFEFFFFERRFFFFRREY YR EE D

KEY
\ 1 STATION 2
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C. This finalizes the Side Street (Y8A) intersection model as shown below.

W

FINALIZED
INTERSECTION
MODEL

Exercise 2 — Directional Crossover with Median U-Turns Modeling

In this exercise, you will learn how to model a Directional Crossover with Median U-Turns. This
includes pavement shearing, median/pavement switching, bulb-outs, directional median cross-over
modeling, intersection radius modeling, application of linear templates, proposed terrain model
development, surface template application, and various element profiling techniques. Design Intent
will continue to be a major focus.

Throughout this exercise you will be working with NCDOT 2D dgn files exclusively. All design and
corridor manipulation will be carried out within a 2-dimensional design plane.

1. Launch OpenRoads Designer CONNECT Edition
Doble-click on the NCDOT Roadway OpenRoads icon on your desktop to launch
OpenRoads Designer into the NCDOT Roadway workspace.

2. Set the Workspace and Workset
Select DOT-US North Carolina from the Workspace menu.
Select NCDOT R-2635C (Training) from the Workset menu.

OpenRoads Designer CONNECT Edition

DOT-US North Carolina - R-2635C (Training) -
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3. Open the Exercise 2 Corridor (CMD) dgn file and zoom in closely to the Super Street
Intersection

A. Click the browse button and path to the Module 11 (Detailed Modeling) folder and

Browse

open the R-2635C-RDY_CMD_Exercise2.dgn file.

B. Zoom in close to the intersection as shown below. For the sake of time and the avoidance of
redundancy a number of elements have already been modeled. The end result after finishing
Exercise 2 will be a completed Super Street model.

SUPER STREET
MODEL

C. In addition to the preemptive modeling, notice that some of the 2D linework has already been
designed allowing this module to focus more on Detailed Modeling. See the Plan Geometry
Module for detailed instructions on 2D plan geometry development.

2D ISLAND 2D ISLAND
| LINEWORK |-~ LINEWORK
Y — AL

2D BULBOUT
LINEWORK
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4. Remove the grass median and display pavement within the Super Street Intersection limits

A. Notice that a portion of the Y8 Corridor has a grass median within the limits of the
Super Street Intersection. This can be adressed using Paramtric Constraints that
are included within the attached NCDOT template.

Y8
CORRIDOR

GRASS
MEDIAN

B. Select the Corridor Objects “The Bucket” tool (Corridors > Edit > & % @
Corridor Objects) and then select the Y8 corridor when prompted to Edit Edits
. Template Drop ™ Il
Locate Corridor.
Edit

C. Notice the three (3) Parametric Constraints that have already been defined as shown below.

X Uy iﬁ'—;'_*u/

Constraint Label Enabled Start Value Stop Value Start Station End Station

:
PYV_Shear Inside LT True -1.0000 20+75.00 30+37 86 E
PV_Shear Inside RT True 1.0000 1.0000 20+75.00 30+37.86

. P S - - S T
— = S — — P ——————

e PV_Shear_Inside LT = Shears the left Inside curb and median when set to -1
e PV_Shear_lInside RT = Shears the right inside curb and median when set to 1
e X_Over_Switch = Displays the median pavement when set to 1
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D. Adjust the start station value for all three (3) Parametric Constraints to 13+27.86 as shown
below. This will remove the median and display the pavement throughout the limits of the
Super Street Intersection.

X 0y ﬁ.-—:-a._,,:/’?

Constraint Label Enabled Start Value Stop Value Start Station End Station
FWV_Median_x_Cwer_... 13227 .86

FV_Shear Inside LT True -1.0000 -1.0000 13+27 .36 30+37.86 ,
PV_Shear Inside RT True 1.0000 1.0000 | 13=27.86 3'I]'+3?.E'~E

” e —— eI e o B — 7

GRASS MEDIAN
REMOVED AND
PAVEMENT DISPLAYED

GRASS
MEDIAN

5. Model the bulb-out on the right side of the Y8 corridor
A. From the Feature Definition Toggle Bar, toggle on the Use Active Feature Definition
button and then select the Road_Edge of Travel feature from the (Linear > Roadway >
Pavement) folder as shown below. Keep this Feature active throughout all steps that follow.

Road_Edge of Travel | ~ !? .’ h:# A f a-d.'?:

G-l Exstin
USE ACTIVE  foo FEATURE
FEATURE G-l Guardrail and Barier DEFINITION
DEFINITION - Interesection DROPDOWN

- Miscellaneous T

EI Favement )

" B Fioad_Edge of Travel {

& Road_Edae of Travel Dasf{
& Road_Edge of Travel Sheat
E Road_Lane Line A b
@ Road_Lane Line B {

» ’J*r-'~n.--_l_||__r|y—--,1-—r
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B. Use the Complex By Element tool (Geometry > Horizontal > Complex Geometry > Complex By
Element) to complex the individual 2D Elements that make up the bulb-out as shown below.
Combining these and making a single complex element will be more efficient for modeling.

Geometry Site Corridors Maodel Detailing Drawing Production Drawing Utilities iTwin View

. Import/Export ~ e D - L, % Offsets and Tapers = EB Open Pr
" ;:\ _:’,a’({ o O ﬂ_ \f.; C

[ Design Elements ~ A Reverse Curves ¥

T . . . |45 Set Activ:

Civil Reports  Lines Arcs  Point Modify ~ Complex .

W Standards T Toggles = v v v T 2 Spirals T r Geometry* | | Profile
General Tools

Horizontal

- e N rfl. Complex ByEIgmentI

F

e e e R T e —

C. Next, select the Profile By Slope From Element tool (Geometry > Vertical > Element Profiles >
Profile By Slope From Element) and select the Complexed Bulb-Out Element when prompted
to Locate First Element To Profile. Then Right-Click to Reset And Complete.

Geometry Site Corridors Model Detailing Drawing Production Drawing Utilities iTwin View Help MNCDOT Roadway
r
< Import/Export ~ e Py - 5 % Offsets and Tapers ~ ;’f BH Open Profile Model L
|#% Design Elements ~ ’:\ 5?‘ C ﬁ A Reverse Curves = \f‘; |5 Set Active Profile Il |: l_ 1
Civil Reports | Lines  Arcs  Point Meodify  Complex Lines Curves Element
W Standards ¥ Toggles = - - - =L Spirals * v Geometry *  [I23 Profile Creation = - - Profiles "_
General Tools Horizontal Vertical == Quick Profile Transition
—— E— e —— B - § —_— > = - £ Profile By Constant Elevation

[  Define Profile By Slope From Paint

= I Profile By Slope From Element I‘
....................................................................... X . e I

______________ l\

————| COMPLEXED
BULB-OUT
ELEMENT

AV

Locate First Element To Profile
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D. When prompted to Locate Reference Element, select the Right EOT line for the Y8 Corridor.
When selecting the Y8 Right EOT line you may notice multiple linear elements sitting on top of
one another. To resolve this, Right-Click to cycle through them and choose the linear element
on level P_RDY_TL_Edge_of_Travel. It's very IMPORTANT to select the correct linear element.

_ | —| Y8 CORRIDOR RIGHT EOT
P_RDY_TL_EDGE_OF_TRAVEL

--- Complex Element: +ETO e
Belongs To: Y&

Festure: Linear\Roadway\Template Points\PavementiTL_Edge of Travel Outside
Active Profile: ProfileByTemplate \ LiLe = ————m—————————
Level: P_RDY_TL_Edge_of_Travel (Edge of Pavt Top)

\ Select Element To Project /

E. Then, key the following parameters into the Profile By Slope From Element dialog and click
through the prompts to Profile the Bulb-Out element using a -2.5% slope from the Y8 EOT as
shown below.

48 Profile By Sl..  —

e Point Selection = All 4
¢ Profile Adjustment = None SILEEET :
e Vertical Offset = 0.0000 Point Selection Al )

e Slope =-2.50% Profile Adjustment |None ]

[] Wertical Offaet 0.0000 :
Slope 280% ]

"""" PROFILED —mmmpL e B Sy

‘ BULB-OUT [~
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6. Shear the Y8 pavement through the Bulb-Out limits
A. From the Feature Definition Toggle Bar, toggle On the Use Active Feature Definition

button and then select the CCE_Target_EOT_Shear_Out_RT feature from the (Linear >

Roadway > Construction Class Element) folder as shown below.

USE ACTIVE
FEATURE
DEFINITION

/8\@ CCE_Target_Shear Out RT

----- @& CCE_Target_EOQOT_Out_RT A
----- @& CCE_Target_G5

----- @ CCE_Target_P5

----- @& CCE_Target_Shear_In

----- @& CCE_Tanget_Shear Out_LT
----- @ CCE_Target_Shear_Out_R
----- @& CCE_Target_SW_LT

----- @& CCE_Target_SW_RT

[r= = T

v|ef M A S

TOGGLE OFF
PERSIST SNAPS
AND RULE

B. Select the Single Offset Partial option (Geometry > Horizontal > Offsets and Tapers > Single
Offset Partial) as shown below and select the Y8 alighment when prompted to Locate

Element.

Geometry

Site Corridars Madel Detailing

Drawing Production Drawing L

« Import/Export ~ _“~l”_ A3 a ¥ Offsets and Tapers ~ j
2 | /O @b -

|#% Design Elements ~

S,

Civil  Reports | Lines A

“ Standards * Toggles = v -

1"
rcs Point | —

Single Offset Entire Elerne

| Single Offset Partial |

C. When prompted for a Start and End Location, snap to the following locations as shown below.
This places the Shear Line.

START SHEAR END
LOCATION f-------nemmmmmmee e LINE  f-oooo LOCATION |
\ \

o
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D. Then, follow the same steps to add two (2) additional Shear Lines that match the limits of the
20’ tangent lines at the beginning and end of the Bulb-Out as shown below.

ADDITIONAL
SHEAR LINE

ADDITIONAL
SHEAR LINE

SHEAR
LINE

rrrrrrrrrrrrrnrnnr R ™ML nrNnnNRRNRRNLLLNLNd

Note: These shear lines are broken up because the longer one in the middle will be used to
build a terrain later in the module.

E. Next, click the Y8 Corridor Object Handle, hover for a moment to display the menu, and then
select the Add Corridor Reference option and add the three (3) Shear Lines as shown below.

b
/_
/
SHEAR LINE 1 SHEARLINE2} | SHEAR LINE 3
NP
t g
; i i i Y8 CORRIDOR
"""""" \ OBJECT HANDLE |

#- - 7R X
ffﬁ ADD CORRIDOR
| REFERENCE
ety
a
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F. The Y8 corridor pavement has been sheard to accommodate the proposed Bulb-Out as shown
below.

SHEARED Y8

CORRIDOR
PAVEMENT

7. Apply a Linear Template to the proposed Bulb-Out linear element ;f_"\
A. Select the Apply Linear Template tool (Model Detailing > Apply Linear Template). o
B. Key the following parameters into the Apply Linear Template dialog. Linea,f’rﬁrﬁpme

e Start = Lock To Start Pick Template 1
e End=LockToEnd BE\NPCR,[,’EJISLEEQS pronayodde T _Dmllewf
e Exterior Corner Sweep Angle = 05° 00’ 00” =3 U."egr e o Tamola 3
oncrete |sland Template 1

L] Template = LNT - C&G Berm Catch SIOpeS Concrete lsland Template Linear 1
. ey _ . LNT- C&G Bemn Catch Slopes :

e Feature Definition = Design . LNT-C&G Bem Catch Slopss with SW li
e Name =Y8 Bulb-Out 1 - Roadway Templates 4
[#- Surface Templates ];

5

1

e R e A PO N

Page | 62



*1 :& Module 11 - Detailed Modeling

C. When prompted to Locate Element To Apply Template, select the proposed Bulb-Out and
begin clicking through the prompts. When prompted to Select Side, move your cursor as
shown below and then continue clicking through the prompts to place the Linear Template.

Select Side - Reflect Option
Mirrar - Alt> Down To Select

D. Notice in the View 2, Default 3D window that the Y8 Bulb-Out 1 Linear Template is now
visible in the 3D model as shown below.

Y8 BULB-OUT 1
LINEAR TEMPLATE

Page | 63



5 f/ Module 11 - Detailed Modeling

8. Create a Proposed Terrain for the Proposed Bulb-Out

A. First, select the Project Profile Range To Element tool (Geometry > Vertical > Profile Creation
> Project Profile Range To Element) as shown below.

Geometry Site Corridors Muodel Detailing Drawing Production Drawing Utilities iTwin View Help NCDOT Readway

z / = I 5 . - . .

1< Impaort/Export _,\-T:_ _/a)j ) O -1 7 Offsets and Tapers \fi‘ ,r‘f HEB Open Profile Model |\\ —

5 Design El ts ¥ - AR C v 4% Set Active Profile

(5 Design Elements Ciwvil Reports | Lines Arcs  Point ‘\L Everse Lunves Modify Complex 2% Lines Curves E

W Standards ~ Toggles » v v v =L Spirals * v Geometry *  [5 Profile Creation = v v Pi
General Tools - Haorizontal E Profile From Surface f

# Quick Profile From Surface

[*> Project Profile To Element

[ Project Profile Range To Element

B. When prompted to Select Element To Project, select the Right EOT line for the Y8 Corridor.
When selecting the Y8 Corridor Right EOT line you may notice multiple linear elements sitting
on top of one another. To resolve this, Right-Click to cycle through them and choose the linear

element on level P_RDY_TL_Edge_of_Travel. It's very IMPORTANT to select the correct linear
element.

Y8 CORRIDOR RIGHT EOT
P_RDY_TL_EDGE_OF_TRAVEL

N

— ||||Illllllt||i|||llllllllllll|||IIIIIlllllII|||Illllll|III||||lllIIlllIlllllillllllll!llllll\.ll' v --
ceme e R “,—o— I IR
—— \\ et
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C. When prompted to Select Plan Element To Project Onto, select the Shear Line that was placed
in the previous step. Use the Alt-Key to Lock the Start/End locations of the Shear Line and
click through the prompts to finalize the profile projection.

D. Notice in the View 2, Default 3D window that the Shear line is now visible in the 3D model as
shown below. This will be used to produce a proposed terrain for the Bulb-Out.
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E. From the Feature Definition Toggle Bar, toggle On the Use Active Feature Definition
button and then select the Draft_DNC feature from the (Linear > Roadway > Miscellaneous)
folder as shown below.

Draft_DMC > |€€ “ "+" r&'\ s

- Civil Cell »
Construction Class Element

- Culvert

Curb and Gutter

-8 Ditch

@ Existing

-l Fence

- Guardrail and Bamier

Interesection

Miscellaneous

¢ EENIN

@& Drain_Grade Fixed Tie

USE ACTIVE
FEATURE
DEFINITION

F. Select the Single Offset Partial option (Geometry > Horizontal > Offsets and Tapers > Single
Offset Partial) as shown below and then set the Offset parameter within the Single Offset
Partial dialog to 1.000.

Geometry Site Corridors Model Detailing Drawing Production Drawing L

<< Import/Export ¥ e e - P Offsets and Tapers :
Hga, :’?5‘5 o O ?_ - -7

#% Design El ts ¥ . - i i i i
l B Civil Reports | Lines  Arcs  Point s

“n Standards ~ Toggles~ = v v T | single Offset Partial |

G. Select the Bulb-Out EOT when prompted to Locate Element and Snap to the Beginning and
End locations of the shear line when prompted for a Start and End Location as shown.

START END
LOCATION LOCATION

_—" | BuLB-OUT
— EOT
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H. This will place a Draft_DNC construction class element with a 1’ offset from the Bulb-Out
along the length of the Shear Line as shown below.

R P R R R R R TR S e o 8 o S o A o L

SHEAR
LINE

DRAFT_DNC OFFSET
1’ FROM BULB-OUT

A

Note: The 1’ offset is temporary and was used to make it easier to work with the Draft_ DNC
element.

I. Next, select the Profile By Slope From Element tool (Geometry > Vertical > Element Profiles >
Profile By Slope From Element) as shown below.

Geometry Site Corridors Madel Detailing Drawing Production Drawing Utilities iTwin View Help MNCDOT Roadway

1< Import/Export ~ o 4 > 2 L ¥ Offsets and Tapers ~ BH Open Profile Model
e - S R SRR g N = B

|#5 Design Elements ~ i Reverse Curves ~ |5 Set Active Profile

Civil Reports Lines  Arcs  Point Modify  Complex Lines Curves Element
W Standards ~ Toggles - b = = v = Spirals ~ = Geometry | [{23 Profile Creation ~ v - Profiles 9
General Tools Horizontal Vertical == Quick Prefile Transition

|-% Profile By Constant Elevation

¥ Define Profile By Slope From Point

\I Profile By Slope From Element
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J. Select the Draft_DNC element when prompted to Locate First Element To Profile, then Right-
Click to Reset And Complete. When prompted to Locate Reference Element, select the Bulb-
Out EOT element.

DRAFT_DNC

K. Then, key the following parameters into the Profile By Slope From Element dialog and click
through the prompts to Profile the Bulb-Out element using a 0.00% slope from the Bulb-Out
EOT as shown below.

ﬁ Profile By Slo

- ¥
e Point Selection = All Parameters ]
e Profile Adjustment = None Point Selection | Al -
e Vertical Offset = 0.0000 . -
Profile Adjustment IE

Slope = 0.00%
. p 6 [] Vertical Ofiset  |0.0000 :

Slope 0.00% i

BULB-OUT
EOT
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L. Next, select the Element Selection tool (Terrain > Selection > Element Selection). Select k
the Shear Line and Draft_DNC elements as shown below. Be sure to select the Shear Elermnent
Line. See Tip below. Selection

Tip: Zoom in closely and right click to tab through until you get the correct line.

M. Then, select the Create Terrain From Elements tool (Terrain > Create > From Elements) as

shown below.
Terrain Geometry Site Corridors I

e 73+ @ From File 00 |
ws| From Graphical Filter  * % ]
s — i Additional

=3 A From Elements Methods #

¥

I Air;ate’ et

tion

—n 4.

N. Still keeping the Shear Line and Draft_DNC elements selected, key the following parameters
into the Create Terrain From Elements dialog.

e Feature Type = Boundary
e Edge Method = None
e Feature Definition = PT_Triangles

48 Create Terr..  — x

f @ No beature Uefinition J

3 = Temain
Parameters i S NCDOT ff
- - Exist j
Festure Type |EI.::.|Jr1|::|.5|r5.r % 20 Prop )
o @ PT_ Boundary ]
Edge Method |Nnne 4 @ PT_Contours y
F “-@ PT_Contours and Triangles
Feat ] ----- @ PT_Drainage Contours 3
are ? @ PT_Thematic Height 1
. 3 i@ PT  Thematic Slope :
Feature Definition |F‘T_ Triangles E ‘@ PT_Triangles .
LSS S — p—— — PP Y - — -~ _,_J
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O. Left click through the prompts to create the Bulb-Out Terrain Model as shown below.

P. After the Bulb_Out Terrain Model has been created, change the Draft_DNC offset to 0.000’,
so that it sits directly on top of the Bulb-Out EOT. See Note below.

| DRAFT_DNC |

BULB-OUT
EOT

Note: As previously mentioned, the Draft DNC 1’ offset was only temporary to make it easier
to work with.
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Q. Notice that the Bulb-Out Terrain Model has been adjusted and now runs along the Bulb-Out
EOT line as shown below.

BULB-OUT
TERRAIN MODEL

R. Next, select the Apply Surface Template tool (Model Detailing > Surface Templates > Apply
Surface Template) as shown below.

Medel Detailing Drawing Productiog
4

DN A2 @D

——

Apply Surface Create 4
arﬁl'gmplate Templates*  Closed Mesh ELI

D —

& Apply Surface Template;

S. Then, key the following parameters into the Apply Surface Template dialog as shown below
and select the Bulb-Out Terrain Model from within the View 2, Default 3D window when

prompted to Locate Terrain Model.

e Template = SFT-Pavement Pick Template

4

e Feature Definition = Disable Linear Features - CANCDOT Training'\Roadway'\Module T

= Project Templates 1

4% Apply Surface Template - - Linear ’
TR e e ? [+~ Roadway Templates j
General 4 = S:Jrface Templates r

y - SFT-Concrete '

Template |Project TemplatesSurface Templates'SFT-Pavement : ; 1

Apply External ClipBoundary (] SSSEE——— 00 0 [

Feature

Feature Definition |D1'sable Linear Features

......

BULB-OUT

TERRAIN MODE “‘\NNN!S\""“F’ -
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T. Continue left clicking through the prompts to apply the SFT-Pavement Surface Template to
the Bulb-Out Terrain Model as shown below.

SFT-PAVEMENT
SURFACE
TEMPLATE

U. Use a combination of Key-Stations and Parametric Constraints to seamlessly connect the
Bulb-Out to the Y8 Corridor as shown below.

16+02.87
13+22.85 KEY- KEY-STATION

STATION

25% CUT AND
FILL SLOPES

10’ BERM
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9. Model the Concrete Islands for Median U-Turns
A. From the Feature Definition Toggle Bar, toggle on the Use Active Feature Definition
button and then select the Monolithic Island feature from the (Linear > Roadway >
Intersection) folder as shown below. Keep this Feature active throughout all steps that follow.

egllMonol'rthic Island I - e'!j? 4#(&\ 6;’” }
o |;

" A onolithic Island

L Migmallepam e ) B ~

Roadway
USE ACTIVE - Bridge FEATURE
FEATURE ﬂ Civil Cel DEFINITION
Construction Class Element
DEFINITION Eﬂ Cudvest DRYOPDOWN
- Curb and Gutter i
- Dich )
- Existing
. @ Fence !
. B8 Guardrail and Bamier 4
EI Interesection :

B. Next, select the Complex By Element tool (Geometry > Horizontal > Complex Geometry >
Complex By Element), set the Method Parameter to Manual and complex the elements
highlighted in purple as shown below.

Geemetry Site Corridors Medel Detailing Drawing Production Drawing Utilities iTwin View

& Import/Export ¥ _\lr_ ?f O ?_ % Offsets and Tapers ~ \J'J ff EH Open Pre
) B 4 L
4% Design Elements : R C v 4 Set Activ,
%% Design Elements Civil Repurts |_II"IE5 Arcs  Point j:_ EVErsE Luves Medify =~ Complex 1% .
9 Standards * Toggles - - - v v =L Spirals * v Geometry* | Profile ¢
G | Tocl Herizontal
en‘era._ Dtli . nrlza?_a _ EJI Complex ByEIementI
4%3 Create - .
———— ELEMENTSTOBE |
Parameters 1

COMPLEXED

Method Manual 1
Maximum Gap 00328 ';
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C. Next, select the Quick Profile From Surface tool (Geometry > Vertical > Profile Creation >
Quick Profile From Surface) and select the Complexed Concrete Island when prompted to
Locate Reference Element.

Geometry Site Corridors Model Detailing Drawing Production Drawing Ltilities iTwin View Help NCDE

F

& Import/Export ~ P % 5 , L Offsets and Tapers = EH Open Profile Model [~
@ ¥ /0% 7 [

|#} Design Elements ~ A Reverse Curves ~ |5 Set Active Profile

. Civil Reports = Lines Arcs  Point Modify  Complex Ling
W Standards * Toggles - v - * =L Spirals ~ ' Geometry * | b Profile Creation =
General Tools Horizontal o k~  Profile From Surface 1
= = — — = = = = ————— — F ]

pI Quick Prafile From Surface I

I

r r

"""""""""""" COMPLEXED
CONCRETE ISLAND
------------------------------- \S —

D. Then, select the Y8 Corridor when prompted to Locate Reference Surface. Right-click to reset
and finalize the command.

Y8
CORRIDOR
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E. Now, open the Profile View for the Complexed Concrete Island and set the new profile to
Active as shown below.

7 """"---...,,._'r
a",*‘ ““ﬁ.
‘_.-"'" | ""h.__“
- 3 -
___.—-""" (CE /' jav = x h"\._‘_
- -
R SET AS o
e . b
P -~ ACTIVE ~
RN /’ PROFILE
N\

F. Notice in the View 2, Default 3D window that the Concrete Island is now displayed in the 3D
model as shown below.
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G. Next, select the Apply Linear Template tool (Model Detailing > Apply Linear
Template) and key the following parameters into the Apply Linear Template i\
dialog. Appl
Linear?gnl"'lrplate

e Start = Lock To Start
e End=Lock To End 2
. @ Apply Linear Template - X
e Exterior Corner Sweep Angle = 05° 00’ 00”
. Parameters ~
e Template = Concrete Island Template Linear Lock To Star
e Feature Definition = Design Start Station 0.0000
Lock To End []
e Name = Y8 ISLAND | “
End Station 0.0000"
Pick Temp|ate 1 E:.deriorCDrnerSweepAngle |D5°DD‘DD"
Mirror [}
=5 C_:\NCDOT Training“"Roadway Module 11 - Deiailed; Reflect 0
= PmJEd Templates Template |Project Templates'Linear'Concrete lsland Template Linear IZ”
B IJ_near Description |
i . Concrete lsland Template
Concrete Island Template Linear Feature ~
; LNT- C&G Berm Catch Slopes ] Feature Definition |Deagn |
¢ i LNT-CAG Berm Catch Slopes with S\W - Name [¥8 ISLAND
[+~ Roadway Templates )
[~ Suface Templates et

bbb e,

H. When prompted to Locate Element To Apply Template, select the Concrete Island and place
the Linear Template as shown below.
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I.  From the Feature Definition Toggle Bar, toggle On the Use Active Feature Definition
button and then select the Draft_DNC feature from the (Linear > Roadway > Miscellaneous)

folder as shown below.

Draft_DMNC - |€{f “ "I“ rﬂ‘\ f

- Civil Cell 3

- Construction Class Element
USE ACTIVE - Culvert
FEATURE - Curb and Gutter
(- Ditch
DEFINITION G- Existing
- Fence
[ Guardrail and Barier
E-[ 1 Interesection
B[ Miscellaneous
@

i@ Drain_Grade Fixed Tie

J. Select the Single Offset Entire Element option (Geometry > Horizontal > Offsets and Tapers >
Single Offset Entire Element) as shown below. Then set the Offset parameter within the Single
Offset Partial dialog to 1.000 and click the single portion of the Concrete Island when
prompted to Locate Element.

Geometry Site Corridors Model Detailing Drawing Production Drawing Litilities Twi
<< Import/Export ~ e Y - F Offsets and Tapers =

o AR 2| SO ¢ = - e

&y Design Elements - .. - . . i F F

. 9 Ciwvil Reports Lines  Arcs F'omtl — _Single Offset Entire Element I _Complex
@ Standards - Toggles~= = v v * [i7  Ssingle Offset Partial ieometry

General Tools Variable Offset Taper

iy

< CONCRETE
ISLAND
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K. Next, select the Extend Line tool (Drawing > Modify > Extend Line) and shorten the
Draft_DNC element that was just offset in the previous step by -0.765 from both ends to

match

Drawing
;- r---1

] '
[ I—

the width of the top portion of the Concrete Island.

Utilities iTwin View Help NCDOT Roadway

2 O~-+ %~ O I =709
/O BRAT

7] O 4 B

" Insert Vertex!
1" Delete Verte

- s ik R

Fence Place Place _ Arc 0 Move Copy Rotate = Modify Break Trim  _ .
Tools* [ Smartline Line Tools~ {‘e] A (g Element Element Multiple | ™
«tion Placement Manipulate Madify

F e n
............... 0765 |
A
@ Extenc —
Distance: -0.7650

DRAFT_DNC WIDTH
MATCHES TOP OF
CONCRETE ISLAND
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L. Inthe View 2, Default 3D window, Snap to the Beginning and End of the Concrete Island to
determine the elevation at the top linear element. This will be used to set a Profile for the

remaining section of the Concrete Island.

348.17'
ELEVATION — —
= ‘E '-.y‘IEﬂiﬂiﬂ‘lSES?, 7266341078, 3481780 KeyPt

348.17
ELEVATION

M. Next, select the Profile By Constant Elevation tool (Geometry > Vertical > Profile Creation >
Profile By Constant Elevation). Set the Elevation parameter to 348.17 and select the
remaining section of the Concrete Island when prompted to Locate Element.

Geometry Site Corridors

Model Detailing Drawing Production Drawing Utilities iTwin

%} FEN o _¢_ 37 Offsets and Tapers ~ \rﬁ f‘{ 28] Open Profile Model b k Ié :—‘_——" &

|4% Set Active Profile

. Import/Export ~ 3 l{_

4r . . K -

!o} Design Elements Civil Reports = Lines Arcs  Point e Modify  Complex

q_ﬁ Standards ~ Toggles ~ - - -

General Tools Horizontal

IV S | N = = Lo ——
REMAINING
SECTION OF
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N. Notice in the View 2, Default 3D window that the final edge of the Concrete Island is now
visible in the 3D model and matches the width and elevation of the previously modeled
portion.

FINAL EDGE OF
CONCRETE ISLAND

0. Next, select the Element Selection tool (Terrain > Selection > Element Selection) and
select the Concrete Island linear elements as shown below.
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P. Then, select the Create Terrain From Elements tool (Terrain > Create > From Elements) as

shown below.
Terrain Geometry Site Corndors ]

71+ @ From File gu.o ]
3| From Graphical Filter a;

o Addition

= Q From Elements Methods‘:
¥

:tlglh_'“ — Crgat‘e’ et

Q. Still keeping the Concrete Island elements selected, key the following parameters into the
Create Terrain From Elements dialog.

e Feature Type = Boundary
e Edge Method = None
e Feature Definition = PT_Triangles

J% Create Terr... — X)
3 - @& Mo reature Uetinition P
P ot j =+ Temain
= - Ewist
Feature Type | Boundary 3 B0 Prop
- ‘@ PT_Boundary b
Edge Methed |NQHE ) i@ PT_Contours y
4 & PT_Contours and Triangles 1
Feat 1 i@ PT_Drainage Contours 1
[z ? @ PT_ Thematic Height f
- & _PT_Thematic Slope 4
Feature Definition |F‘T_ Triangles F m :
e PSP e— . — et e, -

R. Left click through the prompts to create the Concrete Island Terrain Model as shown below.
Notice that the Terrain Model doesn’t look correct along the edge that was Offset by 1’. To
correct this, simply change the Offset to 0’.

CONCRETE ISLAND
TERRAIN MODEL

Note: The 1’ offset was temporarily used to make it easier to manipulate the element.
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S. After changing the Offset to 0’ the Terrain Model has been corrected as shown below.

CORRECTED
TERRAIN MODEL

T. Select the Apply Surface Template tool (Model Detailing > Surface Templates > Apply Surface
Template) as shown below.

Model Detailing Drawing Producti

N2 @D

Apply Surface Create f
ar?gmplate Templates ¥ Closed Mesh El:

A Apply Surface Template‘

U. Then, key the following parameters into the Apply Surface Template dialog as shown below
and select the Concrete Island Terrain Model when prompted to Locate Terrain Model. This
finalizes the Concrete Island.

e Template = SFT-Concrete Monolithic Island-Simple

Pick Template
e Feature Definition = Disable Linear Features

E--Cl:\NCDOT Training"Roadway \Module 11 - Detailed
=8 F‘!'ojed Templates

% Apply Surface Template - > 3 " Linear f
< . [#- Roadway Templates 1
eneral :
= Surface Templates
Template |ijed Templates\Surface Templates\SFT-Concrete Monalithic lsland-Simple :

& SFT-Concrete Monolithic Island-Simple

Apply External Clip Boundary D SFT-Pavemert

Feature

Feature Definition |Disab|e Linear Features
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V. Using the skills taught throughout the Detailed Modeling Module, model the final Concrete

Island that runs along the Y8 Corridor as shown below.

10. Layout the Radius Returns for the Northern side of the Y8/Y18 Intersection
A. Zoom in closely to the Northern side of the Y8/Y18 Intersection.

;
)

]

1]

1}
™y
| IR
i
)

1]

¥

1}

)

]

]

Lr;.ﬂl-u-l-n-n -|-|-|-|-|-|—|-|-H+|-!-%'

Note: Both Corridors are contained within a single CMD file for training purposes only.
Typically, Detailed Intersection Modeling would be carried out within the Secondary

Corridor CMD file. See File Management module for detailed information.
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B. From the Feature Definition Toggle Bar, toggle on the Use Active Feature Definition
button and the Persist Snaps and Rule option. Select the Road_Edge of Travel feature from
the (Linear > Roadway > Pavement) folder as shown below. Keep this Feature active
throughout all steps that follow.

Road_FEdge of Travel

USE ACTIVE
FEATURE
DEFINITION

-
-

Tef @ A /

E::i:g FEATURE PERSIST SNAPS
Guardrail and Barmier DEFINITION AND RULE
It i DROPDOWN

eresection
Miscellaneous 1
Pawement

"4 Road_Fdge of Travel

@& Road_Fdge of Travel Dasl';
@& Foad_Edge of Travel Shea
@& Road_Lane Line A

@& Road_Lane Line B

C R SN T I =

C. Now, select the Simple Arc tool (Geometry > Horizontal > Arcs > Arc Between Elements >
Simple Arc). Set the Radius parameter to 75.0000’ and the Trim/Extend parameter to Back
within the Simple Arc dialog as shown below.

Geometry Site Corridors Model Detailing Drawing Production Drawing Utilities i Twvir
1< Import/Export * e 3 L " Offsets and Tapers ~ 4
Zimeoileot © G P 28 (] @ Ml T
<7 Design Elements = : A" Rewverse Curves ~
' - Civil Reports | Lines Arcs  Point Modify  Complex |
“n Standards * Toggles = i - - * = Spirals ~ i Geometry =
O Circl ]
General Tools - rele -
{~  Arc Between Points ;
Arc To Elernent
JEE 2IMpie a "™ Arc Between Arcs
Parameters Arc From Element :
Trim/Extend Back 1 Arc Between Elements y (1| Simple Arc
Radius 75 0000 ) B Spiral Arc Spiral
T
Loop ] 9. Taperfrc Taper
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D. When prompted to Locate First Element, select the Y18 Left EOT line and then select the Y8
Left EOT line as the Second Element. When selecting the EOT lines you may notice multiple
linear elements sitting on top of one another. To resolve this, Right-Click to cycle through
them and choose the linear element on level P_RDY_TL_Edge_of _Travel. It's IMPORTANT to
select the correct linear element. Continue Left-Clicking through the additional prompts that
follow to place the 75’ Radius Return as shown below.

| N

Y18 LEFT EOT
P_RDY_TL_EDGE_OF_TRAVEL

v

f

Y8 LEFT EOT -
P_RDY_TL_EDGE_OF TRAVEL [

\:=/ DI GNP S T AT e

E. Now, adjust the beginning of the Y18-2 Corridor by Snapping to the end of the 75’ Radius
Return.

—
———— ———

Y18-2
CORRIDOR

75’ RADIUS
RETURN

- T IR e E R R R R R iy

e
—— ——
. ——

|
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F. Next, select the Quick Profile Transition tool (Geometry > Vertical > Element Profiles > Quick
Profile Transition) and click the 75’ Radius Return to Profile it and add to the 3D Model as

shown below.

Geometry Site Corridors Meodel Detailing Drawing Production Drawing Utilities iTwin View Help MNCDOT Roadway

L mpor/Eport * g YD aA () @ L OMesadTpes~ S5 EBOpenbrfieMode |\ TUL TTT v
o oy

gl |4 Set Active Profile

S T

4% Design El ts ~ TR C =

! 3 L MESEE Civil Reports = Lines Arcs  Point Everse bunes Maodify  Complex Lines Curves Element Modify Complex

% Standards * Toggles = v v u - A Spirals ~ v Geometry * b Profile Creation = v v Profiles = v Geometry ~
General Tools Harizontal Vertical L | Quick Profile Transition ]

b et pmen ML e e e e P e S PO

48 Quick Profile..
Parameters

Quick Transition Method | Parabolic i

I
J_\|.~_“M

P S e S pie

75’ RADIUS
RETURN
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G. Then, select the Single Offset Partial tool (Geometry > Horizontal > Offsets and Tapers >
Single Offset Partial and click the Y18 Centerline when prompted to locate element.

Geometrny Site Corridors Madel Detailing Drawing Production Drawing Utilities iTwi
1<~ Import/Export = e P a C) > TV Offsets and Tapers =

% D ; El i t boed _/?5 4 o A -

s Design Elements = - i : :

. ¢ 9 Civil Reports Lines Arcs Point — >ingle Offset Entire Element _Complex
@ Standards ~ Toggles= = v v " | T Single Offset Partial | EREREE I

General Tocls

2

Variable Offset Taper

H. Set the following parameters within the Single Offset Partial dialog and then Snap to the end
of the Y18 Right EOT line as shown below when prompted for a Start location. Click through
the additional prompts to finalize and place EOT line.

J%';E':'e:“:e'ﬁ —
e Offset =12.0000 Perameters
° Length =20.000 Offset: 12.0000
o i f |Use Spiral Transitions [ |
| SNAPTOEND OF f/ Mirror O
Y18 RIGHT EOT i Oej Remove Offset Rule |:|
Distance
Er: Parameters - <Alt> Lock To Lock To Start |
nad
: [ Start Distance @
& | Distance:Length | NI Lock To End O
End Distance 29+25 74
- Length 20.0000
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Help

Utilities iTwin WView
BH Open Profile Model b L P
S
Lines Curves E
pi

Next, select the Project Profile To Element tool (Geometry > Vertical > Profile Creation >
Project Profile To Element) and click the Right EOT line from the Y18-2 Corridor as shown
MNCDOT Roadway .

| 5% Set Active Profile

l.
below when prompted to Select Element To Project.
Drawing Production Drawing
- L F Offsets and Tapers =
S O @ o
Complex
[ Profile Creation ~

Geometry Site Corridors Model Detailing
< Import/Export ~ _\lf_ ;&%}f?
RN
4% Design El t : = =R C v
| Design Elements Civil Reports Lines Arcs  Point ‘\L FVErsE bunes Modify
Toggles = v v v v =L Spirals ~ v Geometry =
_ _ Horizontal b= Profile From Surface
# CQuick Profile From Surface
¥, Project Profile To Element I i
;[ Project Profile Range Te Element |

W Standards *
General Tools
e i anl

| Y18-2 CORRIDOR
RIGHT EOT

When prompted to Select Plan Element To Project Onto, click on the previously placed 20’

J.
EOT line as shown below

20’ EOT
LINE
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K. Then, open the Profile view for the 20’ EOT line and notice the Projected Y18 Right EOT

Module 11 - Detailed Modeling

Profile as shown below.

L. Next, select the Tangent Profile Line From Element tool (Geometry > Vertical > Lines > Profile
Line From Element > Tangent Profile Line From Element). Set the Trim/Extend parameter to

PROJECTED Y18
RIGHT EOT PROFILE

None and the Length parameter to 20.000.
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M. Then, select the Projected Y18 Right EOT Profile when prompted to Locate Element and Snap
to the end of the Projected Y18 Right EOT Profile when prompted for a Start Point. Left-click
through the additional prompts to place the new 20’ Y18 Right EOT Profile element as shown

below.
SNAP FOR START ”J,e*“d JF?.E_E":_:E — }«
POINT i Parameters ;
o : ' Trim/Extend Mone r’
4/ . Length 20.0000 :
1
- P TT———
PROJECTED Y18 - -
RIGHT EOT PROFILE #..-""
-
-
##"

N. Click on the new Y18 Right EOT profile and make it Active. This will add it to the 3D Model as
shown below.

@2 - & X

SET AS ACTIVE
PROFILE

Y18 RIGHT
EOT

‘
L =t
e G N e

1
N

Y18 RIGHT
EOT
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O. Now, select the Simple Arc tool (Geometry > Horizontal > Arcs > Arc Between Elements >
Simple Arc). Set the Radius parameter to 35.0000’ and the Trim/Extend parameter to Back
within the Simple Arc dialog as shown below.

Geometry Site Corridors Model Detailing Drawing Production Drawing Litilities i Twir

< |Import/Export ~ _:l:_ /E_f,f:\ A ﬂ 1*\_ 1 Offsets and Tapers ~ \]H; ,?’f
' > A Reverse Curves ~

g% Design El ts ~ . . ; :
l ssign Hlements Civil Reports = Lines Arcs  Point Modify Complex

i Standards ~ Toggles - * 2 Spirals ~ . Geometry *
General Tools O Circle
fﬂ Arc Between Points ;
Arc To Element
) ™ Arc Between Arcs
Parameters & Arc From Element

Trim/Extend  Back Arc Between Elements f:l_

] P Spiral Arc Spiral
Radius 35.0000°

Loop ]

Yg  Taper Arc Taper

P. When prompted to Locate First Element, select the 20’ Y18 Right EOT line and then select the
Y8 Left EOT line as the Second Element. When selecting the Y8 Left EOT line you may notice
multiple linear elements sitting on top of one another. To resolve this, Right-Click to cycle
through them and choose the linear element on level P_RDY_TL_Edge_of_Travel. It’s very
IMPORTANT to select the correct linear element. Continue Left-Clicking through the additional
prompts that follow to place the 35’ Radius Return as shown below.

20" Y18
RIGHT EOT

Y8 LEFT EOT
P_RDY_TL_EDGE_OF_TRAVEL
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Q. Next, select the Quick Profile Transition tool (Geometry > Vertical > Element Profiles > Quick

Profile Transition) and click on the 35’ Radius Return to Profile and add it to the 3D Model as
shown below.

Geometry Site Corridors Model Detailing Drawing Production Drawing Utilities iTwin View Help NCDOT Roadway

1< Import/Export ~ i %7 2A o ? 3~ Offsets and Tapers ~ \f»ﬂ y“{ EH Open Profile Model |\\ — |_JL v A
|4% Design Elements v M € . . A& Reverse Curves ~ . |44 Set Active Profile — —
. Civil Reperts | Lines  Arcs  Point Meodify  Complex

%y Standards * Toggles v - -

Lines Curves Element Modify Complex 3
2 Spirals * v Geometry v | Profile Creation hd v Profiles = A Geometry v j
General Tools Horizontal Vertical L | Quick Profile Transition I}
P _,L_.-—-I'l_*L-"‘ e B R e e A R e — e | o v S e

35’ RADIUS
RETURN
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11. Apply Linear Templates to the Radius Returns for the Northern side of the Y8/Y18 Intersection
A. Select the Apply Linear Template tool (Model Detailing > Apply Linear Template).
B. Key the following parameters into the Apply Linear Template dialog.

e Start = Lock To Start
e End=Lock To End
e Exterior Corner Sweep Angle = 05° 00’ 00”
e Template = LNT - C&G Berm Catch Slopes
e Feature Definition = Design
4% Apply Linear Template - J
Parameters 3
Lock To Start E
Start Station 0.0000 «J
Lock To End !
End Station 0.0000 j
Exterior Corner Sweep Angle |D§’ﬂ'ﬂ'ﬂ'ﬂ" ‘,
Mirrar O i
Reflect ,
Template |Project Templates'\Linear'LNT- C&G Berm Catch Slopes ?'
B e [

Pick Template

=~ C:ANCDOT Training Roadway'Madule 11 - Detailed I't"I;
= Project Templates

- Linear
! l-Concrete Island Template ]
- Conerete Island Template Linear 1
2 LNT- C&G Berm Catch Slopes
i b LNT-C&G Berm Catch Slopes with SW
-- Roadway Templates
- Surface Templates

g P P

C. When prompted to Locate Element To Apply Template, select the 75’ Radius Return and
place the Linear Template as shown below.
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D. Then do the same for the 35’ Radius Return and short Tangent section that it connects to.

TANGENT
SECTION

35’ RADIUS
RETURN

12. Create Terrain Model for the Northern side of the Y8/Y18 Intersection
A. Select the Project Profile Range To Element tool (Geometry > Vertical > Profile Creation >
Project Profile Range To Element) and click the Y8 Left EOT line when prompted to Select
Element To Project. When selecting the Y8 Left EOT line you may notice multiple linear
elements sitting on top of one another. To resolve this, Right-Click to cycle through them and
choose the linear element on level P_RDY_TL_Edge_of_Travel. It’s very IMPORTANT to select

the correct linear element.

Geometry Site Corridors Model Detailing Drawing Production Drawing Utilities 1Twin View Help NCDOT Roadway J
— | — n o )

1<_ Import/Export ~ a4 2P L+ Offsets and Tapers = ?)f B Open Profile Model | r
|#% Design Elements = "";\ ;’é < o _¢_ A Reverse Curves ™ VYJ |55 Set Active Profile = — 3
. Civil Reports Lines Arcs Point Modify  Complex Lines Curves E
W Standards ~ Toggles = v v v 2L Spirals ~ v Geometry = | [ Profile Creation ~ v v P
General Tools Horizontal Profile From Surface i
P U S )—'-rl-\»—"»_, f
Quick Profile From Surface 4

i

Project Profile To Elernent r

“  Project Profile Range To EIementJ

P_RDY_TL_EDGE_OF TRAVEL '
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B. When prompted to Select Plan Element To Project Onto, select the Shear Line as shown
below. Use the Alt-Key to Lock the Start/End locations of the Shear Line and click through
the prompts to finalize the profile projection.

C. Open the Shear Line Profile View and set the Projected Profile To Active. This will add it to the
3D Model as shown below.

PROJECTED
PROFILE

-
——
———
———
p——
o
L

SET AS ACTIVE
PROFILE

-
-—
—
———
——
e
-
-
s
-
-
e
- —
——
-—
-
-——
-
———
R
e
—-—
oy
———

SHEAR LINE
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D. Now, from the Feature Definition Toggle Bar, toggle On the Use Active Feature Definition
Persist Snaps And Rule buttons. Then select the Draft_DNC feature from the (Linear >
Roadway > Miscellaneous) folder as shown below.

USE ACTIVE
FEATURE
DEFINITION

Draft_DNC

v Mep A S

- Civil Cell

Construction Class Element
Culvert
Curb and Guiter

-l Ditch

-l Existing

-l Fence

-l Guardrail and Bamier

Interesection
Miscellaneous

@ Drain_Grade Fixed Tie

|

PERSIST SNAPS
AND RULE

E. Then, select the Line Between Points tool (Geometry > Horizontal > Lines > Line Between
Points) and Snap to the end of the two (2) Y18-2 Corridor EOT Lines as shown below.
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F. Next, select the Quick Profile From Surface tool (Geometry > Vertical > Profile Creation >
View

Quick Profile From Surface) and select the 24’ Draft_DNC line placed in the previous step
Help  NCDf

when prompted to Locate Reference Element.
Drawing Production Drawing Utilities 1Twin
¥ Offsets and Tapers ~ \_,r"'; y’f EH Open Profile Model b
|#% Set Active Profile T
ing

Geometry Site Corndors Model Detailing
1< Import/Export * Ny ) o I
#3 Design Elements ~ - A Reverse Curves =
! - Civil Reports = Lines Arcs  Point Modify  Complex
Toggles = v - v * =L Spirals ~ - Geometry v b Profile Creation =
Harizontal . - b Profile From Surface
- I Quick Profile From Surface
R - P A Y "

W Standards *
General Tools

24
DRAFT DNC

|
{
!
/
!
{
!
!
!
{
!
f
!
{
!
!
]

e

G. Then, select the Y18-2 Corridor when prompted to Locate Reference Surface. Right-click to

reset and finalize the command.
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[ 1t i
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i 1 i /
1 ' i /
i i /
1 I [ /
' it /
1 i /
| i /
| H i /
| 1] H /
{ /i i /
i I /
: 1! P ,rjI
/ Y18-2
iy Il
f i :
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H. Open the Draft_DNC Profile View and set it as the Active Profile. This will add it to the 3D
Model as shown below.

DRAFT_DNC

2 7% X|

SET AS ACTIVE
PROFILE

DRAFT_DNC

I. Next, select the Element Selection tool (Terrain > Selection > Element Selection) and k
select the Linear Elements from the Northern Side of the Y8/Y18 Intersection as shown Element
below. Selection
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J. Then, select the Create Terrain From Elements tool (Terrain > Create > From Elements) as

shown below.

Terrain Geometry Site Corndors
d

:;‘;: i3 = ¢ FromFile gun }
3| From Graphical Filter

> - £ Additiona
=4 A& From Elements Methods =
L

:ti_DnP e o C‘r'gatje’ _—

K. Still keeping the Y8/Y18 Intersection elements selected, key the following parameters into the
Create Terrain From Elements dialog and Left-Click through the prompts to create the Terrain
Model as shown below.

e Feature Type = Boundary
e Edge Method = None
e Feature Definition = PT_Triangles

4% Create Terr — X
o @ Mo reature Uetinition ]
3 - Temain
Parameters f ©-0 NCDOT :
- [ Ewist |
Feature Type | Boundary * & Prop 'J
- L@ PT_Boundary 1
Edge Method |Ncne r @ PT_Contours )
F - @ PT_ Contours and Triangles 1
1 - @ PT_ Drainage Contours 1
Feature ? - @ PT_ Thematic Height 1
.- 3 PT_Thematic Slope :
Feature Definition |F‘T_ Triangles F PT_ Triangles 3
prump _— - e
- . — — P F o
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L. Next, select the Add Features tool (Terrain > Edit > Feature Management > Add Features), set
the Feature Type to Break Line and select the Y8/Y18 Intersection Terrain Model when
prompted to Locate Terrain Model To Add Elements.

Terrain Geormetry Site Corridars Maodel Detailing Drawing Production Drawing
s {71~ B From File %”“ A% % 8y Edit Complex Model -

3| From Graphical Filter v Feature M t
o = . Additional Topo Active  Edit _ﬁﬁ Fature Vanagemen ;
=: 4% From Elements Methods = Import = v Model &y I Add Features L

ticn Create & Remove Features
——— = - N R .

o bttt b — - F R Ser— — - " -
5 — = S B —

Y8/Y18
INTERSECTION
TERRAIN MODEL

M. When prompted to Locate Element To Add, select the Y18 Alignment and Click through the
prompts to add the Break Line to the Terrain Model as shown below.

Y18 ALIGNMENT :

Locate Element To Add \»

—_—

=
Y18 BREAK LINE "»-&
—

‘//,I\
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13. Apply Pavement Surface Template to the Y8/Y18 Intersection Terrain Model

A. Select the Apply Surface Template tool (Model Detailing > Surface Templates > Apply Surface
Template) as shown below.

Model Detailing Drawing Productioy

=\ 2 gy

Apply surface Create
arq'gmplate Templates ¥ Closed Mesh F—'_f

& Apply Surface Template

&

B. Then, key the following parameters into the Apply Surface Template dialog as shown below
and select the Y8/Y18 Intersection Terrain Model when prompted to Locate Terrain Model.

e Template = SFT-Pavement
e Feature Definition = Disable Linear Features

Pick Template

= C.: WNCDOT TrainingRoadway Madule 1
(- Project Templates 1

6{& by S e Ter At o . B+l Linear
G e e " - Roadway Templates
General y =3 S:urface Templates

i SFT-Concrete

Template |Pr0ject TemplatestSurface Templates'\SFT-Pavement
Lpply External Clip Boundary [

Feature

Feature Definition |Disable Linear Features

Y8/Y18
INTERSECTION

T Wi~
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il
0

A

o i
Ay WA

C. Continue clicking through the prompts to apply the SFT-Pavement Surface Template to the
Y8/Y18 Intersection Terrain Model as shown below.

D. Use a combination of Key-Stations and Parametric Constraints to seamlessly connect the
Y8/Y18 Intersection to the Y8 Corridor as shown below.
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14. Add Concrete Channelization Island to the Northern side of the Y8/Y18 Intersection
A. From the Feature Definition Toggle Bar, toggle on the Use Active Feature Definition
button and then select the Monolithic Island feature from the (Linear > Roadway >
Intersection) folder as shown below. Keep this Feature active throughout all steps that follow.

l;}Il Monolithic Island I R | ¢ 4 I"I"' A f p
e e + ¥
~___

- Roadway
USE ACTIVE ...g Bridge FEATURE
FEATURE G- Civil Cell DEFINITION
DEFINITION Congtruction Class Element DROPDOWN
- Culvert L
[+ Curb and Gutter
- Ditch
- Existing
H Ferce
G- Guardrail and Barrier
EI Interesection
L@
= Mizoslleranys

B. Next, select the Single Offset Entire Element tool (Geometry > Horizontal > Offsets and
Tapers > Single Offset Entire Element), set the Offset parameter to 15.0000 and select the 75’
Radius Return to place one (1) edge of the Concrete Island as shown below.

Geometry Site Corridors Model Detailing Drawing Production Drawing Utilities i

< Import/Export ~ b > ~ L 1V Offsets and Tapers ™
e &t ¥ |/ 0 ¢ E per T o :
|#% Design Elements ~ _'1 single Offset Entire Elementl Complex

N Ciwil R-Eports Lines  Arcs  Point |
“¥ Standards ~ Toggles = - - M M 7 Single Offset Partial jeometry "
General Tools <L Variable Offset Taper

\

Parameters

75’ RADIUS |/ \
RETURN Dffset: 15.0000
Llse“Spiral Transitions [

Enter Offset
& Parameters:Offset: | SENEI
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C. Then, continue using the Single Offset Entire Element tool and Offset the Shear Line by 4’ as
shown below.

/

/ SHEAR LINE |\
% F'arameters Offset: | EHITIN —

R o o N N
F}}Pfff**}}fff}#}}.‘tf*}}?f fFF}ifffFF}}fff}**}ffff**}?fff**l&tft

B R

D. For the third Concrete Island edge, select the Single Offset Partial tool (Geometry >
Horizontal > Offsets and Tapers > Single Offset Partial), set the following parameters within
the Single Offset Partial dialog, select the Y18 Alignment, and click through the prompts to
place the third Concrete Island edge. 2

& 2Ingle UNTset F -

Parameters

Offset: 0.0100 ‘

IUze Spiral Transitions [

Mirrar ]
Remove Offset Rule [

e Offset =0.0100
e Start Distance = 28+50.00
e End Distance = 29+00.00

Distance
Lock To Start [l

Start Distance @
Lock Te End |

End Distance 25+0000 °
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E. Next, select the Simple Arc tool (Geometry > Horizontal > Arcs > Arc Between Elements >
Simple Arc). Set the Trim/Extend parameter to Both within the dialog as shown below.

Geometry Site Corridors Model Detailing Drawing Production Drawing Utilities iTwir

. Import/Export ~ o Eﬁé? P ﬂ 5 ¥ Offsets and Tapers ~ \r_&' ;’f {

Mgk, —
¥ A Reverse Curves ~

% Design El ts ~
1% Design Elements Civil Reports Lines Arcs  Point Modify  Complex
9 Standards * Toggles ~ - - - 2 Spirals ~ - Geometry
General Tools O Circle
- 3{* Arc Between Points ’ -

Arc To Element
"™ Arc Between Arcs

Arc From Element

Arc Between Elements i‘ﬂ Simple Are F

B Spiral Arc Spiral I

lc_f._ ~ Taper.Arc Taper;,

F. Now, use the Simple Arc tool to fillet the three (3) corners of the Concrete Island as shown
below.

\
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G. Use the Complex By Element tool (Geometry > Horizontal > Complex Geometry > Complex By
Element), set the Method to Automatic and Complex the individual 2D elements that make up
the Concrete Island as shown below.

Geometry Site Corridors Maodel Detailing Drawing Production Drawing Utilities iTwin View

1« Import/Export ~ s 4 9 o L % Offsets and Tapers = B Open Pri
.-;\ _//a’f o o ﬂ_ \fJ

|45 Design Elements ~

¢ T Reverse Curves # Set Activi

Civil Reports = Lines Arcs  Point :L FvErse bunE Medify = Complex % 3

Wy Standards * Toggles - v v v * 2L Spirals * v Geometry v | | Profile d
General Tools Horizental

N

@ Create — ;
Parameters ;

Method Automatic
Maximum Gap 0.0328

g

H. Next, select the Quick Profile From Surface tool (Geometry > Vertical > Profile Creation >

Quick Profile From Surface) and select the Complexed Concrete Island when prompted to
Locate Reference Element.

Geometry Site Corndors Model Detailing Drawing Production Drawing Utilities iTwin View Help MNCDE

3

£ Import/Export ¥ o P - L X Offsets and Tapers ~ EH Cpen Profile Model
@ 2 /0% 7 =

% Design El ts ¥ “a R C v 4% Set Active Profile
(85 Design Elements Civil Reports = Lines Arcs  Point FYEIsE e Modify  Complex 1% ing
W Standards * Toggles = v v v * 2L Spirals - v Geometry * | | Profile Creation = v

General Tools Horizontal - b Profile From Surface

pI Quick Profile From Surface I

[

il P L

COMPLEXED
CONCRETE ISLAND
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I. Then, select the Y8/Y18 Intersection Terrain Model when prompted to Locate Reference

’{Lg Module 11 - Detailed Modeling

Surface. Right-click to reset and finalize the command.

J.  Open the Concrete Island Profile View and set it as the Active Profile. This will add it to the 3D

Model as shown below.

CONCRETE
ISLAND

CONCRETE
ISLAND
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K. Next, select the Apply Linear Template tool (Model Detailing > Apply Linear

LMT- C&G Berm Catch Slopes

Template) and key the following parameters into the Apply Linear Template "':\
dialog. Aprply
Linear Termplate
e Start = Lock To Start
o End = |.0Ck TO End 4% Apply Linear Template — )
e Exterior Corner Sweep Angle = 05° 00’ 00” Parameters f
e Template = Concrete Island Template Linear Lock To Start :
o _ . Start Station 0.0000° {
e Feature Definition = Design Lock T End {
End Station 0.0000" j
Pick Template Exterior Corner Sweep Angle |D5°DD'DD" E
¥ ) 1
[=- C:ANCDOT TrainingRoadway ' Module 11 - Deeanedi Mirror | :
=8 F'!'oject Templates Reflect J
E‘ Ugneégnme leland Template f Template |F‘roject Templates'\Linear\Concrete lsland Template Linear
Concrete Island Template Linear ? Description | - R -.rN.____....o~‘J,
4

i - LNT-CAG Bem Catch Slopes with SW
£~ Roadway Templates
[+~ Surface Templates
S .,

S

e -

L. When prompted to Locate Element To Apply Template, select the Concrete Island and place

the Linear Template as shown below.
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M. Next, select the Element Selection tool (Terrain > Selection > Element Selection) k‘
and select the Top Edge of the Concrete Island as shown below. Element

Selection

CONCRETE ISLAND
TOP EDGE

N. Then, select the Create Terrain From Elements tool (Terrain > Create > From Elements) as

shown below.
Terrain Geometry Site Corndors I

i {71+ @™ From File %-0 ]
L 2| From Graphical Filter a;

- Addition
= A& From Elements Methods

i
tion — Cr t‘E‘__’_'__J
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O. Still keeping the Concrete Island elements selected, key the following parameters into the
Create Terrain From Elements dialog and Left-Click through the prompts to create the Terrain
Model as shown below.

@ No Feature Uetinition

e Feature Type = Boundary

B+ Temain
e Edge Method = None & NCDOT
N . G- Bist
e Feature Definition = PT_Triangles =- ) Prop
@ PT_ Boundary

Q PT_ Contours
@ PT_Contours and Triangles
@ PT_ Drainage Contours

PO S e T .

48 CreateTerr..  — >) @ PT_Thematic Height

'3 @ PT_Thematic Slope 1

Parameters e e @ PT_Tnangles o
Feature Type | Boundary B
)
Edge Method  [None I
Feature ;

Feature Definiticn |F‘T_ Triangles
I S e——— L —

P. Select the Apply Surface Template tool (Model Detailing > Surface Templates > Apply Surface
Template) as shown below.

Model Detailing Drawing Productiof
4

DN A2 @

5
Apply Surface Create ’
ar%mplate Templates ¥ Closed Mesh E'J

& Apply Surface Template;
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Q. Then, key the following parameters into the Apply Surface Template dialog as shown below
and select the Concrete Island Terrain Model when prompted to Locate Terrain Model. This
finalizes the Concrete Island.

calls . Pick Te | ]

e Template = SFT-Concrete Monolithic Island-Simple ek femplate F

. ere . . = CANCDOT Training\Roadway\Module 11 - Detailed M,

e Feature Definition = Disable Linear Features - Project Templates {

-- Linear (

ﬁ Apply Surface Template — b4 J‘ .. Roadway Templates E

T 1
- Suface Templates 1
SFTConcrete Monolithic Island-Simple }
i SFT-Pavement 1

General

Template |F'rojed Templates'\.Suface Templates'.SFT-Concrete Monolithic Island-Simple

Apply External Clip Boundary []

Feature

Feature Definition |Disab|e Linear Features

bt A, S — — — —— =

15. Finalize the Directional Crossover with Median U-Turns Modeling by using a combination of Key-
Stations and Parametric Constraints to seamlessly connect all the Corridors as shown below.

FINALIZED DIRECTIONAL
CROSSOVER WITH
MEDIAN U-TURNS
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